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INTRODUCTION

INTRODUCTION
This document explains how to manage color output on the Fiery EX8000AP Color Server
and provides information about calibration and color profiles.
This document is part of a set of documentation that includes manuals for users and system
administrators. For a complete description of your Fiery EX8000AP Color Server, see the
other documents available at your site.
For more information about supported operating systems and system requirements, see
Welcome.

Terminology and conventions
This document uses the following terminology and conventions.
Term or convention

Refers to

Aero

Fiery EX8000AP (in illustrations and examples)

Command WorkStation

Command WorkStation, Windows Edition and
Command WorkStation, Macintosh Edition

Digital press

DocuColor 8000AP digital press

Fiery EX8000AP

Fiery EX8000AP Color Server

Mac OS

Apple Mac OS X

Titles in italics

Other documents in this set

Windows

Microsoft Windows 2000, Windows XP,
Windows Server 2003
Topics for which additional information
is available by starting Help in the software
Tips and information

Important information

Important information about issues that can result
in physical harm to you or others
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About this document
This document is organized to supply you with key information about managing the color
output of your Fiery EX8000AP.
This document covers the following topics:
• Installing and configuring ColorWise Pro Tools
• Using Color Editor, Profile Manager, and Color Setup
• Overview of calibration and description of how to calibrate the Fiery EX8000AP using
various ColorWise Pro Tools Calibrator methods
• Using Spot-On to manage spot colors
• Setting ColorWise print options from Windows and Mac OS computers
• Descriptions of Simple ASCII File Format (SAIFF), which can be used to import toner
density measurements from measurement devices
N OTE : Glossary defines color terms and concepts in bold throughout this document, for
example, output profile. If you are new to desktop color, or if any terms are unfamiliar, see
Glossary.
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Key features of ColorWise
ColorWise is the color management system (CMS) built into the Fiery EX8000AP and
designed to provide both casual and expert users with the best color output for a variety
of purposes. The ColorWise default settings provide high-quality, out-of-box color from
many Windows and Mac OS applications. This allows casual users to achieve quality output
without knowing about or changing any color settings on the Fiery EX8000AP.
For consistent color, calibrate the Fiery EX8000AP on a regular basis. ColorWise Pro Tools
includes an easy-to-use calibrator, which allows you to calibrate using an optional
spectrophotometer or densitometer (see “Calibration” on page 31).
ColorWise features allow you to modify printing results. Depending on your particular needs,
you can:
• Set the behavior of CMYK printing to emulate DIC, Euroscale, SWOP, and other offset
press standards.
• Match PANTONE and other spot colors for the best match when printing using
four-color press conditions or presses with extra, custom plates.
• Select a color rendering dictionary (CRD), also called a rendering style, for RGB
printing. CRDs allow for rich, saturated printing of presentation graphics, smooth,
accurate printing of photographs, and relative or absolute colorimetric rendering for
specialized needs.
• Define the source of incoming RGB color data for better color conversion of RGB data
with no source information.
• Determine whether RGB data is converted into the full gamut of the digital press or is first
converted into the gamut of another device, such as a press standard. This feature is useful
for making one device behave like another for RGB data. It also allows you to evaluate the
appearance of an RGB file under different printing conditions without having to convert
the RGB file to CMYK first.
ColorWise color management (ColorWise) offers an open color architecture, allowing
users to customize the Fiery EX8000AP to meet new printing needs as they arise. ColorWise
supports ICC profiles, which are industry standard color profiles that describe the color
behavior of a device. Note that ICC specification version 4 profiles (profile version 4.2.0.0)
are supported as well as version 2. Downloading ICC profiles to the Fiery EX8000AP enables
the Fiery EX8000AP to simulate a custom press (or another digital press), as well as accurately
print colors from a particular monitor or scanner. In addition, you can create customized ICC
profiles for the digital press.
ColorWise also allows you to use any Status T densitometer by importing data in a standard
file format (see “Importing Density Measurements” on page 92). In this case, it is important
to note that the quality of the instrument used determines the quality of the calibration.
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COLORWISE PRO TOOLS
The ColorWise default settings provide high-quality out-of-box color from many Windows
and Mac OS applications. This allows casual users to achieve quality output without knowing
about or changing color settings on the Fiery EX8000AP. The ColorWise color management
system (CMS) also allows expert users to obtain the best color output. ColorWise Pro Tools
allows users to customize settings to achieve the best output for a variety of purposes.
Designed to give flexible control of color printing, ColorWise Pro Tools includes the
following color management tools:
• Calibrator (calibrate the Fiery EX8000AP in various ways)
• Color Editor (customize simulation and output profiles)
• Profile Manager (manage profiles)
• Spot-On (define CMYK equivalents for spot colors)
• Color Setup (set defaults for ColorWise print options)
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About this chapter
This chapter describes the procedures for installing, configuring, and using ColorWise Pro
Tools on Windows and Mac OS computers.
Platform

To do this

See

Windows

Install ColorWise Pro Tools

page 12

Install the ICC profiles

page 12

Configure the connection

page 14

Modify the configuration

page 15

Install ColorWise Pro Tools

page 16

Install the ColorSync profiles

page 17

Configure the connection

page 19

Modify the configuration

page 20

Use Calibrator

page 21

Use Color Editor

page 21

Use Profile Manager

page 23

Use Spot-On

page 28

Use Color Setup

page 29

Mac OS

Windows and Mac OS
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Setting up ColorWise Pro Tools on a Windows computer
The following sections describe how to install ColorWise Pro Tools and other files and
configure the connection on a Windows computer.

Installing ColorWise Pro Tools
All installation of user software on a Windows computer is done through the Fiery User
Software Installer. The procedures in Utilities describe installing from the User Software DVD
or the network.
To use ColorWise Pro Tools on a Windows computer, you must install Sun Java 5. If this file
is not installed on your computer, the ColorWise Pro Tools installer automatically initiates the
installation process. Follow the on-screen instructions.

Installing the ICC profiles
You can copy additional ICC profiles from the Fiery EX8000AP to your computer. Use the
ICC profiles with applications that support ICC standards, such as Adobe Photoshop. For
most ICC-aware applications, you must install the files in a folder named Color. For use with
ColorWise Pro Tools, copy the files to a folder of your choice.
TO INSTALL THE ICC PROFILES ON A WINDOWS COMPUTER
1 Browse for the Fiery EX8000AP over the network, using the IP address or the DNS server
name.
2 Type the user name and password, if required.

Consult with your network administrator to see if this is required.
3 Double-click the PC_User_SW directory.
4 Open the ICC folder.
5 Right-click the profile that you want, and then click Install Profile.

The profiles are installed automatically to the Windows\System32\spool\drivers\color folder
(Windows XP) or WINNT\System32\spool\drivers\color folder (Windows 2000) on your
computer.
Color files
You can copy additional color files from the Fiery EX8000AP. Many of the files are PostScript
files that you can download and print using Command WorkStation.

COLORWISE PRO TOOLS
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CMYK Color Reference.ps: An 11-page, Letter-size PostScript file

used for reference when defining CMYK colors in applications.
PANTONE Book.ps: A 20-page, Letter-size PostScript file that

indicates the closest equivalent of PANTONE coated colors that
the Fiery EX8000AP and your digital press model can produce.
The method used to print the PANTONE Book.ps file differs
depending on the Spot Color Matching setting. For more
information, see “Spot Color Matching” on page 84.
RGB page 01.doc: A file you can print from Microsoft Word 97

or later to view available RGB colors.
RGB page 02.ppt: A file you can print from PowerPoint 6.0 or

later to view available RGB colors.
Color Bars folder
(inside the Windows
Color Files folder)

FieryColorBar.eps: A file used for the Control Bar option. For

PS Files folder
(inside the Windows
Color Files\
Calibration Files
folder)

Custom21.ps, Custom34.ps, Standard21.ps, and Standard34.ps:

more information about Control Bar, see Graphic Arts Package.
Can be used to print a color control bar.
PostScript files of color patches for obtaining measurements.
The numbers in the file names refer to the number of patches on
the page. The Custom files allow you to download measurement
patches that incorporate the current calibration set of the digital
press. The Standard files allow you to download standard
measurement patches that bypass the current calibration set of
the digital press.
N OTE : These files are provided for expert users and should not be

used for day-to-day calibration.
Halftone Calibration
Files folder
(inside the Windows
Color Files\
Calibration Files
folder)

Images of measurement pages for various calibration instruments
and page sizes, used for calibrating the Fiery EX8000AP for
different halftone screens. Files are provided for Photoshop and
other applications. For more information about halftone
calibration, see Graphic Arts Package.
N OTE : For the X-Rite DTP32 Series II densitometer, use the

calibration file for the X-Rite DTP32 densitometer.
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Configuring the connection
The first time you start ColorWise Pro Tools, you must configure the connection to the Fiery
EX8000AP.
BEFORE YOU BEGIN
Print the Configuration page from Command WorkStation and note the IP address of the Fiery
EX8000AP.

This page contains information that you need when configuring the connection, such as the
IP address. For TCP/IP installations, you can use the Domain Name Server (DNS) name of
the Fiery EX8000AP instead of the IP address. Make sure the Fiery EX8000AP is listed in a
DNS used by your network. For more information, see the documentation that accompanies
your Windows system.
TO CONFIGURE THE CONNECTION FOR COLORWISE PRO TOOLS
1 Start ColorWise Pro Tools.
2 If the Choose Printer Device dialog box appears, click Add.
3 Enter the appropriate information for the Fiery EX8000AP.
Nickname: Type a name for the Fiery EX8000AP. This name does not have to match the

actual Server Name of the Fiery EX8000AP.
N OTE : The nickname cannot contain the following characters:

[ ] _ " ' <space> <tab>
Server Name or Server IP address: Type the IP address (or DNS name) of the Fiery

EX8000AP.
New Device: Type the device name of the Fiery EX8000AP: DC8000AP.

4 After you type all the information, click Add.
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5 With the device name (DC8000AP) selected in the Devices list, click OK.

The Fiery EX8000AP appears in the list of Available Servers. The first line of the entry
displays the nickname you assigned the Fiery EX8000AP, followed by the protocol.
The second line displays the device name.

6 With the device name selected in the list of Available Servers, click Select.

The ColorWise Pro Tools main window appears.

Editing the configuration
Edit the configuration whenever a change to your Fiery EX8000AP or network occurs, such
as a server name or IP address change. Change the specific Fiery EX8000AP Setup
information before you configure the connection.
TO EDIT THE CONFIGURATION
1 To add a new Fiery EX8000AP, click Add. Configure the Add New Server dialog box as outlined
in steps 3 through 5 in the previous procedure.
2 To remove a Fiery EX8000AP, select the Fiery EX8000AP by its nickname and click Remove.
3 To modify information, select the Fiery EX8000AP by its nickname and click Modify. Edit the
information in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
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Setting up ColorWise Pro Tools on a Mac OS computer
The following sections describe how to install ColorWise Pro Tools and other files and
configure the connection on a Mac OS computer.

Installing ColorWise Pro Tools on a Mac OS computer
Before you begin each installation, determine where you want to install each item on your
hard disk. Otherwise, the software is placed in the “Fiery” folder by default.
TO INSTALL COLORWISE PRO TOOLS ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD
1 Insert the User Software DVD into the DVD drive.
2 Browse to the folder for your operating system.
3 Double-click the ColorWise Pro Tools installer icon.
4 Follow the on-screen instructions.
5 If prompted, click Quit to close the installer.

TO INSTALL COLORWISE PRO TOOLS ON A MAC OS COMPUTER OVER THE NETWORK
1 Choose Connect to Server from the Go menu.
2 Type smb:// followed by the IP address of the Fiery EX8000AP and click Connect.

If you cannot locate your Fiery EX8000AP, contact your network administrator.
3 Enter user name and password if required.

Check with your Network Administrator to see if this is required.
4 Double-click the icon for the Mac_User_SW directory.
5 Open the OS X folder.
6 Double-click the ColorWise Pro Tools installer icon.
7 Follow the on-screen instructions.
8 If prompted, click Quit to close the installer.
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Installing the ColorSync profiles
You can copy additional ICC profiles from the Fiery EX8000AP to your computer, if
required. Use the ICC profiles with applications that support ICC standards, such as
Photoshop. For most ICC-aware applications, you must install the files in a folder named
Profiles in the Library:ColorSync folder. For use with ColorWise Pro Tools, you can copy the
files to a folder of your choice.
TO INSTALL THE COLORSYNC PROFILES ON A MAC OS COMPUTER
1 Choose Connect to Server from the Go menu.
2 Type smb:// followed by the IP address of the Fiery EX8000AP and click Connect.

If you cannot locate your Fiery EX8000AP, consult your network administrator.
3 Type user name and password if required.

Consult your network administrator to see if this is required.
4 Double-click the Mac_User_SW directory.
5 Open the ColorSync folder.
6 Install the profiles into Library: ColorSync: Profiles.

After you install the ColorSync files, see the ColorSync documentation for setting ColorSync
profiles, such as EFIRGB.

COLORWISE PRO TOOLS
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Color files
You can copy additional color files from the User Software DVD. Many of the files are
PostScript files that you can download and print using Command WorkStation.

Mac Color
Files folder

CMYK Color Reference.ps: An 11-page, Letter-size PostScript file to

use for reference when defining CMYK colors in applications.
PANTONE Book.ps: A 20-page, Letter-size PostScript file that indicates
the closest equivalent of PANTONE coated colors that the Fiery
EX8000AP and your particular digital press model can produce. The
method used to print the PANTONE Book.ps file differs depending
on the Spot Color Matching setting. For more information, see
“Spot Color Matching” on page 84.
RGB page 01.doc: A file you can print from Microsoft Word 97 or

later to view available RGB colors.
RGB page 02.ppt: A file you can print from PowerPoint 6.0 or later to
view available RGB colors.

Color Bars folder
(inside the Mac
Color Files folder)

FieryColorBar.eps: A file used for the Control Bar option. For more
information about Control Bar, see Graphic Arts Package. Can be
used to print a color control bar.

PS Files folder
(inside the Mac
Color Files:
Calibration Files
folder)

Custom21.ps, Custom34.ps, Standard21.ps, and Standard34.ps:

PostScript files of color patches for obtaining measurements.
The numbers in the file names refer to the number of patches on the
page. The Custom files allow you to download measurement patches
that incorporate the currently installed calibration set. The Standard
files allow you to download standard measurement patches that
bypass the currently installed calibration set.
N OTE : These files are provided for expert users and should not be used for
day-to-day calibration.

Halftone Calibration
Files folder
(inside the Mac
Color Files:
Calibration Files
folder)

Images of measurement pages for various calibration instruments and
page sizes, used for calibrating the Fiery EX8000AP for different
halftone screens. Files are provided for Photoshop and for other
applications. For more information about halftone calibration, see
Graphic Arts Package.
N OTE : For the X-Rite DTP32 Series II densitometer, use the calibration file
for the X-Rite DTP32 densitometer.
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Configuring the connection
The first time you start ColorWise Pro Tools, you must configure the connection to the Fiery
EX8000AP.
N OTE : ColorWise Pro Tools is supported only over TCP/IP networks.

BEFORE YOU BEGIN
• Print the Configuration page from Command WorkStation and note the IP address of the Fiery
EX8000AP.

This page contains information that you need when you configure the connection. For TCP/
IP installations, you can use the Domain Name Server (DNS) name of the Fiery EX8000AP
instead of the IP address. Make that sure the Fiery EX8000AP is listed in a DNS used by your
network. For more information, see the documentation that accompanies your Macintosh
system.
TO CONFIGURE THE CONNECTION FOR COLORWISE PRO TOOLS
1 Double-click the ColorWise Pro Tools icon.

The Choose Printer Device dialog box appears.

2 If the No Servers Configured dialog box appears, click OK. If the Choose Printer Device dialog
box appears, click Add.

COLORWISE PRO TOOLS
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3 Type the appropriate information for the Fiery EX8000AP.
Nickname: Type a name for the Fiery EX8000AP. It does not have to match the actual server

name of the Fiery EX8000AP.
N OTE : The nickname cannot contain the following characters:

[ ] _ " ' <space> <tab>
Server name or Server IP address: Type the IP address (or DNS or host name) of the Fiery

EX8000AP.
New Device: Type the device name for the Fiery EX8000AP: DC8000AP. This device name

appears in the Printer Setup section of the Configuration page.
4 After you type all the information, click Add.
5 With the device name selected in the Devices list, click OK.

The Fiery EX8000AP appears in the list of Available Servers. The first line of the entry
displays the nickname you assigned the Fiery EX8000AP, followed by the protocol.
The second line displays the device name.

6 With the device name selected in the list of Available Servers, click Select.

The ColorWise Pro Tools main window appears.

Editing the configuration
Edit the configuration whenever a change to your Fiery EX8000AP or network occurs, such
as a server name or IP address change. Change the specific Fiery EX8000AP Setup
information before you configure the connection.
TO EDIT THE CONFIGURATION
1 To add a new Fiery EX8000AP, click Add. Configure the Add Server dialog box as outlined in
steps 3 through 5 in the previous procedure.
2 To remove a Fiery EX8000AP, select the Fiery EX8000AP by its nickname and click Remove.
3 To modify information, select the Fiery EX8000AP by its nickname and click Modify.
Edit information in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
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Using ColorWise Pro Tools
ColorWise Pro Tools gives you flexible control of color printing by allowing you to calibrate
the Fiery EX8000AP, customize simulation and output profiles, manage profiles on the Fiery
EX8000AP, manage spot colors, and set default values for ColorWise print options.

Using Calibrator
ColorWise Pro Tools Calibrator allows you to calibrate the Fiery EX8000AP using a number
of measurement methods. For information about calibrating the Fiery EX8000AP, see
page 31.

Using Color Editor
ColorWise Pro Tools Color Editor allows you to create custom profiles by editing existing
simulation or output profiles, and then saving the changes as a new profile. Use Color Editor
to fine-tune a profile on the Fiery EX8000AP to meet your exact specifications. Access Color
Editor directly, by clicking its icon in the ColorWise Pro Tools main window, or indirectly,
through Profile Manager.
N OTE : You cannot edit source profiles. Only simulation and output profiles can be

customized.
TO USE COLOR EDITOR
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

2 Click Color Editor.
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3 From the View menu, choose Simulation to list the simulation profiles resident on the Fiery
EX8000AP. Choose Output to list the output profiles resident on the Fiery EX8000AP.
4 Select a profile and click Select.

For more information about Color Editor, see ColorWise Pro Tools Help.
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Using Profile Manager
ColorWise Pro Tools Profile Manager allows you to manage and edit ICC profiles.
TO USE PROFILE MANAGER
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

2 Click Profile Manager.

The Profile Manager window appears.

1

Output profiles

1

3 Click any profile to select it.

Information about the profile, such as its creation date and ICC specification version, appears
at the bottom of the window. Note that ICC specification version 4 profiles (profile version
4.2.0.0) are supported, as well as version 2.
For more information about Profile Manager, see ColorWise Pro Tools Help.
For information about the Use Media Defined Profile option, see the following section.
For information about using Device Link Profiles, see page 24.
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Setting the default profiles
Use Profile Manager to set a default RGB source profile, simulation profile, or output profile.
The default RGB source and simulation profiles that you set are applied to all print jobs sent
to the Fiery EX8000AP, unless you override them using print options. The same is true of the
default output profile that you set, unless you select the Use Media Defined Profile option.
The Use Media Defined Profile option indicates whether or not to automatically apply the
output profile associated with the media type used in a print job. For more information, see
the following section.
Using media-defined output profiles
Instead of having Profile Manager apply a default output profile to all your print jobs, you can
keep the Use Media Defined Profile option selected. This option automatically applies the
output profile predefined for the media type in your print job. If your job contains mixed
media, this option can apply different output profiles predefined for the different media.
The Use Media Defined Profile option in Profile Manager is selected by default. It is applied
to all print jobs sent to the Fiery EX8000AP, unless a user overrides it for an individual job by
changing settings in the printer driver.
TO USE MEDIA-DEFINED OUTPUT PROFILES
1 Start ColorWise Pro Tools and click Profile Manager.
2 Select Use Media Defined Profile in the Output bar of Profile Manager.

Changing the setting for the Use Media Defined Profile option in Profile Manager
automatically changes the same setting in Color Setup. For more information, see
“Using Color Setup” on page 29.
About Device Link Profiles
The Fiery EX8000AP supports the use of Device Link Profiles. A Device Link Profile
describes the conversion from one color space to another. Device Link Profiles are restrictive
because they define the complete conversion from a source device to a destination device.
When you print using a Device Link Profile, you do not choose a source profile or an output
profile because the Device Link Profile specifies both. ColorWise supports two kinds of
Device Link Profiles: RGB source to CMYK destination and CMYK source to CMYK
destination.
A Device Link Profile bypasses most ColorWise color management because the information
needed to convert from the source to destination is fully contained in a Device Link Profile.
N OTE : Depending on your job’s workflow, you may not need to use Device Link Profiles.
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Installing Device Link Profiles
If you are an administrator, you can download Device Link Profiles to the Fiery EX8000AP
using Profile Manager. You must associate a Device Link Profile with the following settings:
• An RGB Source Profile or a CMYK Simulation Profile setting and
• An Output Profile setting
The Device Link Profile is enabled when these two settings are selected.
You can enable a Device Link Profile in three locations:
• In ColorWise Pro Tools Color Setup, select the default settings for RGB Source Profile,
CMYK Simulation Profile, and Output Profile. These settings apply to all jobs unless
overridden for a particular job.
• Use Expert Color Settings in the Fiery EX8000AP printer drivers to select the settings for
RGB Source Profile, CMYK Simulation Profile, and Output Profile when you print a job.
• Use Command WorkStation Job Properties to override the settings for RGB Source
Profile, CMYK Simulation Profile, and Output Profile for a specific job.
For more information about enabling Device Link Profiles using Color Setup, see page 30.
For more information about enabling Device Link Profiles using Expert Color Settings in the
Fiery EX8000AP printer driver, see page 90.
TO DOWNLOAD DEVICE LINK PROFILES USING PROFILE MANAGER
1 In Profile Manager, if you do not see the Device Link Profile in the Description list, select the
folder that contains the Device Link Profile by clicking Browse in the upper-left corner.
2 Click OK to add the folder contents to the Description list.

The Device Link Profile is added to the Description list.
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3 To add the Device Link Profile to the Device Link panel, select the Device Link Profile in the
Description list, and click the green arrow pointing to the Device Link panel.

1

Device Link Panel

1

The Device Link Profile Settings dialog box appears. To assign settings, see the following
procedure.

Assigning Device Link Profile settings
The following Device Link Profile Settings dialog box images depict an RGB Source profile
description. If you use a CMYK Simulation profile, the screen reflects a CMYK Simulation
profile description instead of an RGB Source profile description.
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TO ASSIGN DEVICE LINK PROFILE SETTINGS
1 After you download the Device Link Profile using Profile Manager and add it to the Device
Link Profile panel, select the source and output profiles for this Device Link Profile in the
Device Link Profile Settings dialog box.

If the Device Link Profile already has a source and output referenced, the Output and Source
Profiles automatically appear.
If the source or output profile referenced in the Device Link Profile is not found on the Fiery
EX8000AP, the source profile shows “Unassigned” and a message appears, stating that the
source or output profile cannot be found.

Click Information for more detail about the missing profile.
If you install the source or output profile to the Fiery EX8000AP that matches the missing
profile referenced in the Device Link Profile, the “Unassigned” setting is automatically
updated.
N OTE : If the source or output setting is unassigned, the Device Link Profile cannot be used.

You must assign settings.
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2 If the Device Link Profile does not have a source or output assigned, select a Profile
Description name, and the source and output profiles for the Device Link Profile.

3 After you finish assigning settings to the Device Link Profile, click OK.

Modifying Device Link Profiles
To modify the Device Link Profile settings, use the following procedure.
TO MODIFY DEVICE LINK PROFILE SETTINGS
1 Double-click the Device Link Profile in the Device Link panel.

The Device Link Profiles Settings dialog box appears.
2 Enter the new Source and Output profiles.
3 Click Apply and then click OK.

N OTE : You cannot edit the Device Link Profile in ColorWise Pro Tools. You must use the

application that was used to create the Device Link Profile.

Using Spot-On
Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents.
The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries.
Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on
the Fiery EX8000AP. For more information about Spot-On, see page 48.
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Using Color Setup
ColorWise Pro Tools Color Setup allows you to set the default values for the ColorWise print
options and print settings for the Fiery EX8000AP.
These settings are applied to all print jobs sent to the Fiery EX8000AP, unless a user overrides
them for an individual job by changing settings in the printer driver. These default settings
can also be overridden using Command WorkStation. In addition, the defaults set in Color
Setup are automatically reflected in other Fiery EX8000AP tools that list default settings.
The options in Color Setup are arranged in a pattern representing the flow of color processing
that takes place on the Fiery EX8000AP. To reset the Fiery EX8000AP to its factory default
settings, click Factory Default in the lower-left corner of the Color Setup window.
TO USE COLOR SETUP
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

2 Click Color Setup.
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For information about the Control Bar, configurable Auto Trapping, Progressives, and
Halftone Simulation features in Color Setup, see Graphic Arts Package.
Using Color Setup to enable Device Link Profiles
You can enable Device Link Profiles using Color Setup.
For information about installing and assigning Device Link Profiles, see page 25.
TO USE COLORWISE COLOR SETUP TO ENABLE DEVICE LINK PROFILES
1 Open Color Setup from ColorWise Pro Tools.
2 Select the RGB Source profile or the CMYK Simulation Profile and the Output Profile.

When you select a source and output combination that is defined as a Device Link Profile, the
Device Link Profile is automatically activated.
When the Device Link Profile is selected, the Color Process workflow updates and some of the
Fiery print options may not appear.
You will see the message “Device Link Profile in use” under the RGB Source Profile or CMYK
Simulation Profile.

1

Device Link Profile in use

1

3 Click OK to exit Color Setup.
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CALIBRATION
Calibrating the Fiery EX8000AP ensures consistent and reliable color output. Calibrate
the Fiery EX8000AP using ColorWise Pro Tools Calibrator with a densitometer or a
spectrophotometer.
This document uses the following terminology for color measurement instruments:
Term

Refers to

DTP32 or DTP32 Series II

X-Rite DTP32 or DTP32 Series II automatic densitometer

DTP41

X-Rite DTP41 automatic spectrophotometer

ES-1000

Spectrophotometer ES-1000 hand-held spectrophotometer
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About this chapter
This chapter describes the procedures for calibrating the Fiery EX8000AP using ColorWise
Pro Tools Calibrator with various color measurement instruments. The following table
provides the location of each procedure.
Calibration method

See

DTP32 or DTP32 Series II with Calibrator

page 37

DTP41 with Calibrator

page 39

ES-1000 with Calibrator

page 41

If you defined a custom halftone screen, you must calibrate the Fiery EX8000AP for
that halftone screen before you print a job with it. For more information, see Graphic Arts
Package.
This chapter also describes important concepts and suggestions for understanding calibration.
The following table provides the location of each description.
For more information about

See

An overview of calibration

page 45

How calibration works

page 45

Scheduling calibration

page 47

Checking calibration status

page 47

N OTE : The procedures described in this chapter are fundamentally the same for Windows and

Mac OS computers. Illustrations from a Windows computer are used in this chapter.
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Calibrating with ColorWise Pro Tools Calibrator
ColorWise Pro Tools Calibrator allows you to calibrate the Fiery EX8000AP using the
measurement method of your choice.
Changing calibration has the potential to affect all jobs for all users, so consider limiting the
number of people authorized to perform calibration. Set an Administrator password to
control access to calibration (see Configuration and Setup).
N OTE : Multiple users can be connected to one Fiery EX8000AP with ColorWise Pro Tools,

but only one user at a time can use Calibrator. If you try to calibrate when another user is
using ColorWise Pro Tools to calibrate, an error message appears.

Starting Calibrator
Start Calibrator from the ColorWise Pro Tools main window.
TO CALIBRATE THE FIERY EX8000AP USING CALIBRATOR
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

For information about configuring the connection to the Fiery EX8000AP, see pages 14
and 19.
2 Click Calibrator.
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3 Choose a method from the Select Measurement Method menu.

1

Calibration methods

1

Procedures for each calibration method are described in subsequent sections of this chapter.

Expert mode
Calibrator provides two modes: Standard and Expert. You can perform all essential calibration
tasks while in Standard mode. Expert mode offers two additional options: Print Pages and
View Measurements.

1

Calibration methods

1
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With the Print Pages option, print Comparison Pages showing the results of the new
measurements with any profile associated with the currently selected calibration set. You can
create a custom Comparison Page and save it as a PostScript or Encapsulated PostScript (EPS)
file called CALIB.PS. Print the file to the Hold queue of the Fiery EX8000AP from your
application. You can also create a CALIB.PS file by renaming any job in the Hold queue using
Command WorkStation (see Utilities).
With the View Measurements option, you can view the current set of measurements as a table
or graph that shows both the measurements and the target curves.

1

Output profile name

1

When more than one profile uses the same target, an additional menu called Plot Against
appears in the upper-right corner of the dialog box. It lists all output profiles that use that
same calibration set. Selecting an output profile from this menu displays the target curves
associated with that profile. If each output profile contains a unique calibration target, the
curves displayed also change when you switch profiles.

Applying measurements to multiple calibration sets
The Apply to all calibration sets option in Calibrator allows you to copy the measurements
from the calibration you are currently performing to all calibrations sets on the server. This
option is only available if the Fiery EX8000AP has more than one calibration set. It is selected
by default.
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If you deselect Apply to all calibration sets, you can choose to apply the current calibration to
a selected subset of the calibration sets on the server. To specify which sets, click Customize,
which opens the Apply To dialog box.

Select or clear individual calibration sets, and then click OK.
If any of the selected calibration sets are not associated with an output profile, a warning
appears, but you can choose to apply the calibration measurements to that set anyway.
The calibration measurements are copied to the specified calibration sets at the end of the
calibration process when you click Apply.

Restoring default calibration measurements
Use the following procedure to return to factory default calibration measurements.
TO RESTORE DEFAULT CALIBRATION MEASUREMENTS
1 In the Calibrator dialog box, click Restore Device.
2 Click OK to restore the preset default calibration set.

N OTE : If the Apply to all calibration sets option is selected, all calibration sets on the server are

restored. If Apply to all calibration sets is cleared, Restore Device applies only to the
calibration sets selected under Customize.
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Calibrating with the DTP32 or DTP32 Series II
Using the DTP32 or DTP32 Series II densitometer, you can measure color patches generated
by the digital press and automatically download the measurements to the Fiery EX8000AP.
N OTE : Before you use ColorWise Pro Tools to calibrate the Fiery EX8000AP, set up and

calibrate the DTP32 or DTP32 Series II. For instructions, see the documentation that
accompanies the instrument.
TO CALIBRATE THE FIERY EX8000AP USING THE DTP32 OR DTP32 SERIES II
1 Start Calibrator.

For instructions, see page 33.
2 In the Select Measurement Method pane, choose X-Rite DTP32 or X-Rite DTP32 Series II.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media
and screen you use most often.
N OTE : For this calibration to take effect, the calibration set must be associated with one or

more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations.
4 Click Print in the Generate Measurement Page pane.

The Print Options dialog box appears.
5 Choose the appropriate options and click Print.
Page Type: Choose 21 or 34 Sorted Patches.
Paper Size: Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11 x 17/A3 or
12 x 18/SRA3 for 34 Sorted Patches.
Input Tray: Specify the paper source.

6 Retrieve the measurement page from the digital press.
7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box displays the specified Page Type and
Paper Size options.
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8 Click Measure.

Follow the on-screen instructions to feed the measurement page through the DTP32.
N OTE : The DTP32 Series II does not have an edge guide for the page. Position the page so

that the strip to be measured is lined up directly under the alignment mark.
The Status field displays instructions for selecting the port and feeding the measurement page
through the DTP32 four times, once for each color strip.
DTP32

DTP32 Series II

9 When the Status field indicates that the measurements were read successfully, click Accept.
10 Click OK in the Measure dialog box.
11 Click Apply in the Calibrator dialog box to implement the new calibration set.
12 Click OK in the Information dialog box.

This completes the calibration process.
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Calibrating with the DTP41
Using the DTP41 spectrophotometer, you can measure color patches generated by the digital
press and automatically download the measurements to the Fiery EX8000AP.
N OTE : Before you use ColorWise Pro Tools to calibrate the Fiery EX8000AP, set up and

calibrate the DTP41. For instructions, see the documentation that accompanies the
instrument.
TO CALIBRATE THE FIERY EX8000AP USING THE DTP41
1 Start Calibrator.

For instructions, see page 33.
2 Choose X-Rite DTP41 as the measurement method.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media
and screen you use most often.
N OTE : For this calibration to take effect, the calibration set must be associated with one or

more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations.
4 Click Print in the Generate Measurement Page pane.

The Print Options dialog box appears.
5 Choose the appropriate options and click Print.

Page Type: Choose 21 or 34 Sorted Patches.
Paper Size: Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11 x 17/A3 or

12 x 18/SRA3 for 34 Sorted Patches.
Input Tray: Choose the paper source for printing the measurement page.
6 Retrieve the measurement page from the digital press.
7 In the Get Measurements pane, click Measure.

The Measurement Options dialog box appears, displaying the specified Page Type and Paper
Size options.
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8 Click Measure.
9 If necessary, choose the appropriate COM port for the DTP41 from the Available Ports menu,
and then click Start Measurements.

10 Feed the measurement page into the DTP41, starting with the cyan strip.

Align the page in the measurement page slot of the DTP41 so that the appropriate color
column is centered below the alignment mark. Insert the page about three inches, past the
front idler rollers, until it rests against the rear drive rollers and you feel resistance.
11 Click Read Strip.

The DTP41 pulls the measurement page through automatically.
After the measurement page is read, Calibrator instructs you to insert and align the page again
for the next color.
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12 Repeat the measurement process for the magenta, yellow, and black strips.

A check mark appears on the circle of the color just read, and the Status field indicates the
color was measured successfully.
Use the Previous and Next buttons to reverse or advance to another step in the measurement
sequence.
13 When the Status field indicates that all four color strips have been read successfully, click
Accept Measurements.
14 Click OK in the Measure dialog box.
15 Click Apply in the Calibrator dialog box to implement the new calibration set.
16 Click OK in the Information dialog box.

This completes the Fiery EX8000AP calibration process.

Calibrating with the ES-1000
Use ColorWise Pro Tools in conjunction with the ES-1000 spectrophotometer to calibrate
the Fiery EX8000AP.
N OTE : Before you use ColorWise Pro Tools to calibrate the Fiery EX8000AP, set up and

calibrate the ES-1000. For instructions, see the documentation that accompanies the
instrument.
TO CALIBRATE THE FIERY EX8000AP USING THE ES-1000
1 Start Calibrator.

For instructions, see page 33.
2 Choose ES-1000 as the measurement method.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media
and screen you use most often.

CALIBRATION

42

N OTE : For this calibration to take effect, the calibration set must be associated with one or

more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations.
4 Click Print in the Generate Measurement Page pane.

The Print Options dialog box appears.
5 Choose the appropriate options and click Print.

Page Type: Choose 21 or 34 Sorted Patches or 21 or 34 Randomized Patches. Sorted patches

are printed on the page in the order of their hue and saturation levels. Randomized patches
are printed on the page in random order to help compensate for density inconsistencies on
different areas of the page.
Paper Size: Automatically set to LTR/A4 for 21 patches. Choose 11 x 17/A3 or
12 x 18/SRA3 for 34 patches.
Input Tray: Automatically set to Auto Select.
6 Retrieve the printed measurement page from the digital press.
7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.

Page Type is automatically set to the type that you selected in step 5.
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8 Check the settings and click Measure.

The Information dialog box appears.

9 Place the ES-1000 in the calibration cradle.

When you place the ES-1000 in the calibration cradle, white point calibration is used to
calibrate the spectrophotometer and compensate for gradual drifts in the instrument. Make
sure the sample aperture is in full contact with the white tile on the calibration cradle. If you
do not place it correctly in the calibration cradle, the spectrophotometer does not return
accurate measurements.
10 Click OK.

The Measurements dialog box appears. Instructions for measuring the strips appear in the
Status field.

11 For a more accurate measurement, place several sheets of plain white paper beneath the
measurement page.

The extra sheets block underlying colors from being read by the instrument.
12 Orient the measurement page so that strips are horizontal and the scan direction (indicated
by the arrows at the beginning of each strip) is left to right.
13 Hold the ES-1000 with its length perpendicular to the scan direction, and place the sample
aperture in the white space at the start of the specified color.
14 Press and hold the Measure button and wait for a beep or wait for the background color in the
dialog to change from green to white.

N OTE : To hear a beep with a Windows compatible computer, you must install a sound card

and speaker(s). You may have to turn up the volume on your computer to hear the beep.
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15 After you hear a beep or see the dialog background color change, slide the ES-1000 at a slow
but consistent pace across the strip.

Allow about five seconds to slide the length of the strip.
16 Release the button when all the patches in the strip have been measured and you reach the
white space at the end of the strip.

When a strip is measured successfully, the dialog background color changes to green, and the
cross hair moves to the next color. If the strip is not measured successfully, the dialog
background color changes to red, and a message directs you to try again.
17 Repeat steps 13 through 16 until all the strips are measured.

N OTE : You must measure in the order outlined in the Status field.
18 When all the patches have been read successfully, click Accept.
19 Click Apply in the Calibrator dialog box.

The new calibration measurement is applied.
20 Click OK in the Information dialog box.

This completes the Fiery EX8000AP calibration process.
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Understanding calibration
The following sections describe important concepts and suggestions for understanding
calibration.

An overview of calibration
Calibration generates curves that adjust for the difference between the actual toner densities
(measurements) and the response expected by the output profile.
• Measurements represent the actual color behavior of the digital press.
• Calibration sets are sets of measurements that combine media and screen options provided
for Calibrator.
• Each output profile contains a calibration target that describes the expected behavior of the
digital press.
After you calibrate the Fiery EX8000AP, a calibration set is stored. This calibration set is used
when it is associated with an output profile. Every output profile has an associated calibration
set. If you have not specified one, the calibration set associated with the default output profile
is used.
If you change the calibration after a saved job has been processed (RIPped), you do not have
to reprocess (reRIP) the job. The new calibration affects the job without reprocessing.
N OTE : Changing calibration has the potential to affect all jobs for all users, so consider

limiting the number of people authorized to perform calibration. Set an Administrator
password in Fiery EX8000AP Setup to control access to calibration (see Configuration and
Setup).

How calibration works
Although the needs of most users are met by the default calibration set, the Fiery EX8000AP
allows you to choose a calibration set to customize calibration for specialized jobs.
Calibration allows you to:
• Maximize the color reproduction capabilities of the Fiery EX8000AP.
• Ensure consistent color quality over time.
• Produce consistent output across Fiery EX8000AP servers.
• Achieve better color matches when reproducing spot colors, such as PANTONE colors or
other named color systems.
• Optimize the Fiery EX8000AP for using ColorWise rendering styles (CRDs), CMYK
simulations, and ICC profiles.
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Success in obtaining satisfactory print quality from the Fiery EX8000AP depends on many
factors. Among the most important are establishing and maintaining optimal toner densities.
The density is the measure of the light absorbed by a surface. By carefully regulating toner
densities, you obtain consistent printed color.
Even with a calibrated system, toner density is affected by the settings of digital press,
humidity, and temperature. Density also tends to drift over time. Uneven toner density on
paper affects calibration results. Regular measurement detects day-to-day variations in density,
gradation, and color reproduction. Calibration corrects these variations.
Calibration works by creating calibration curves on the Fiery EX8000AP that compensate for
the difference between actual (measured) and desired (target) density values. These calibration
curves are the graphic equivalent of transfer functions, which are mathematical descriptions of
changes that are made to the initial data. Transfer functions are often graphed as input or
output curves.
The Fiery EX8000AP generates calibration curves after comparing measured values to the
final target values for each of the four toner colors. The target values are based on the output
profile specified.
Measurements
Measurement files contain numerical values that correspond to the toner density produced by
the digital press when it prints solid cyan, magenta, yellow, and black, and graduated tints of
those colors.
To create a measurement file, print a page of color patches. Measure the patches using a color
measurement instrument connected to a computer on the network The new measurements
are automatically downloaded to the Fiery EX8000AP.
Output profiles and calibration sets
Output profiles and calibration sets define desired calibration results. One or more output
profiles and calibration sets are provided with the Fiery EX8000AP. When you calibrate the
Fiery EX8000AP, select the calibration set that corresponds to the typical printing jobs at
your site. This same calibration set can be associated with one or more output profiles. For
more information about output profiles, see page 80.
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Scheduling calibration
Calibrate the Fiery EX8000AP at least once a day, depending on the volume of print jobs.
If it is very important to maintain consistent color, or your digital press is subject to wide
fluctuations in temperature or humidity, calibrate every few hours. For optimal performance,
calibrate whenever there is a noticeable change in print quality or printing results are not as
expected.
If you must split a print job into two or more batches to print at different times, it is
important to calibrate before you print each batch. You should also calibrate the Fiery
EX8000AP after digital press maintenance. However, because the digital press may be less
stable immediately after maintenance, wait until you have printed approximately 50 pages
before you calibrate.
N OTE : Because printed output from the digital press is very sensitive to changes in

temperature and humidity, do not install the digital press near a window, in direct sunlight, or
near a heater or air conditioner. Paper is also sensitive to climate changes. Store it in a cool,
dry, stable environment, and keep reams sealed until they are used.
To monitor print quality, print the following color pages:
• Color Charts (from Command WorkStation)
• Color reference pages included in the User Software DVD (see pages 12 and 18)
These pages include fully saturated color patches and pale tints of cyan, magenta, yellow,
and black. Images with skin tones offer a good basis for comparison. Save and periodically
compare the pages you print. If a noticeable change in appearance occurs, calibrate the Fiery
EX8000AP.
When you examine the Test Page, all color patches should be visible, even though they may be
very faint in the five to two percent range. Each patch set should show uniform gradation
from patch to patch as the color lightens from 100% to zero.
If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated over
time, show the pages to your digital press service technician to determine whether adjusting
the digital press can improve output.

Checking calibration status
To verify whether the Fiery EX8000AP is calibrated, which calibration set and output profile
were used, and when the digital press was last calibrated, perform the following:
• Print a Configuration page or Test Page from Command WorkStation.
• Select a calibration set in Calibrator. The last calibration and the user who performed it
are displayed.
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SPOT-ON
The Spot Color Matching print option automatically matches spot colors with their best
CMYK equivalents so that spot colors can be simulated using the CMYK toner of the digital
press. However, you may want to adjust the default CMYK equivalents to achieve a better
match for your specific printing conditions. You can modify spot colors using Spot-On.
In addition to managing “named” colors, Spot-On allows you to create a list of “substitute”
colors. These are colors that, when called for in a document by their RGB or CMYK values,
are substituted with a different color having the CMYK values from the Spot-On color
dictionary. This permits exact color control and overrides individual RGB and CMYK colors.

Using Spot-On
Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents.
The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries.
Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on
the Fiery EX8000AP.
N OTE : To use the Spot-On features with named colors, you must enable the Spot Color

Matching print option. For more information about this option, see page 84.
N OTE : Spot colors identified by names are printed with their defined CMYK values. The edits

to the output profile made with Color Editor do not affect how spot colors print.
Some Spot-On features require that a job be displayed with correct colors on your monitor.
To display the colors correctly on your monitor, you must set up the monitor display
according to the manufacturer’s recommendations, and specify the correct monitor profile for
your monitor.
Specify the following settings for the monitor display:
• At the monitor: Brightness, Contrast, and Temperature
• From the control panel of the operating system: Resolution, Refresh rate, and Number
of colors
For more information about setting up your monitor and the monitor profile, see the
documentation that accompanies the monitor.
N OTE : The edits to a job made with the color adjustment features in ImageViewer affect all

colors in the job, including spot colors. For more information about ImageViewer, see
Graphic Arts Package.
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Starting Spot-On
To use Spot-On, you must specify the output profile associated with the Spot Color
Dictionary that you want to edit.
If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using
Spot-On, you will get 50%M when you print a job with Output profile X. If you print a job
with Output profile Y, you will get the original value. If you select Output profile X and create
a custom color named “My Purple” and define it as 80C 40M, ColorWise automatically
calculates the Lab values using Output profile X and creates new CMYK values for use with
Output profile Y.
N OTE : The Fiery EX8000AP allows only one user to connect to Spot-On at a time.

TO START SPOT- ON
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

2 Click Spot-On.

The Select Output Profile dialog box appears.
3 Choose an output profile and click OK.

1
2

Current output profile
Output profiles to link

1
2

The Spot-On main dialog box appears. The CMYK values displayed in the dialog box are
calculated with respect to the specified profile.
N OTE : When you print a job, choose the same output profile from the printer driver as the

one that is selected in the Select Output Profile dialog box. Otherwise, color adjustments
based on Spot-On have no effect.
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Spot-On main window
The Spot-On main window list color groups that represent libraries of spot colors on the
Fiery EX8000AP. Tool icons for working with colors appear at the top of the window.
1
1
2
3
4
5
6
7
8
9
10
11
12
13

Output profile
Save
Upload
Download
Cut
Copy
Paste
Close All
Print
Up
Down
Custom color group
Default color group

2

3

4

5

6

7

8

9

10

11

12
13

By default, the Fiery EX8000AP includes several PANTONE libraries along with a System
library. These factory default libraries appear marked with the default group icon (
).
The DIC, HKS, and TOYO libraries are also available with Spot-On.
You can add custom color groups and colors to the Spot-On window (see page 53). Added
groups appear marked with the custom group icon (
). Both default and custom groups
can be opened to display the included colors.
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TO OPEN AND CLOSE A COLOR GROUP
1 To open a color group, click the icon to the left of the group name.

When you open a group, all the colors in the group are displayed, and the group icon changes
appearance.

2 To close a color group, click the icon to the left of the group name.
3 To close all the color groups in the list, choose Close All from the Edit menu.

Working with existing colors
Spot-On allows you to view and manage existing groups of colors on the Fiery EX8000AP
and search for a particular color in the Spot-On list.
Color groups in the Spot-On window appear in order of their priority. Highest priority is
assigned to color groups at the top of the list. For instance, if two colors from two different
color groups have the same name, the Fiery EX8000AP uses the color from the higher group
and disregards the other color. By managing the priority of colors in this way, you can
maintain several CMYK variants for the same spot color.
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TO REARRANGE THE PRIORITY OF COLORS
1 To rearrange an entire color group, select the desired color group.
To rearrange an individual color, select the desired color.

Individual spot colors are marked with circular color icons.
2 To move the selection up or down in the list, click the Up or Down icon in the toolbar.
3 To paste the selection in a different location in the list, click the Cut or Copy icon in
the toolbar.

N OTE : The Cut operation is available only for custom colors.
4 Click the location in the list where you want to paste the cut or copied selection, and then
click the Paste icon in the toolbar.

When you paste a default PANTONE color or group, a warning message appears asking you
to rename the selection because of the multiple prefixes and suffixes for the PANTONE colors
and groups. Use the menus to choose the desired prefix and suffix for the new name, and then
click OK. The pasted selection becomes a custom color or group with the specified name.

TO FIND A SPECIFIC COLOR
1 Choose Find from the Edit menu.

The Find dialog box appears.
2 Enter the name of the color that you want to find and click OK.

Spot-On searches for the specified color, starting from the top of the color list. Once located,
the color appears selected in the color list.
3 To find additional colors based on the same search criteria, choose Find Again from the
Edit menu.
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Creating custom colors
Spot-On provides a number of default color groups in the color list. You can add your own
custom spot colors and groups to the list.
TO ADD A NEW COLOR OR COLOR GROUP
1 Select the location in the group or color list where you want the addition to be placed.
2 Choose New Group from the Edit menu to insert a new group, or choose New Color to insert a
new color.

A new color group entry or color entry appears as Untitled.
TO RENAME A CUSTOM COLOR OR GROUP
1 Select the specific color or group that you want to rename.
2 Double-click the name of the color or group.
3 Type the new name exactly as it appears in the job, including uppercase and lowercase
characters and spaces, as needed.

This new name is supplied by the source application (such as Adobe Illustrator or
QuarkXPress) to your PostScript job.
If you do not have access to the source document, use Postflight to view the list of the exact
color names used in your job. A Postflight Detailed Report prints all the named colors used in
a document. For more information about using Postflight, see Graphic Arts Package.
N OTE : Default groups or colors (such as PANTONE) cannot be renamed.
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Downloading custom color groups
You can download custom color groups from your computer to the Fiery EX8000AP.
Downloaded groups are added as custom groups to the Spot-On color list and are
immediately enabled for use on the Fiery EX8000AP.
TO DOWNLOAD CUSTOM COLOR GROUPS
1 Select the location in the color list where you want to add the downloaded group.
2 Choose Download from the File menu.

The Select file dialog box appears.

N OTE : The supported file format for download is ICC Named Color Profile.
3 Locate and select the desired color group and click Open.

The downloaded group is added to the specified location in the Spot-On list. If you did not
specify a location, the group is added to the top of the list.
If the downloaded group has the same name as an existing group in the list, you are prompted
to rename the downloaded group.
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Uploading custom color groups
You can upload custom color groups from the Fiery EX8000AP to your computer as ICC
files. The upload feature allows you to share a group by creating a local copy that can be
downloaded to another Fiery EX8000AP.
You must save a color group to the Fiery EX8000AP before you can upload it to your
computer. To upload a factory default group, copy and paste the group as a new custom
group, and upload the group as required.
TO UPLOAD CUSTOM COLOR GROUPS
1 Select the name of the color group that you want to upload.
2 Choose Upload from the File menu.

The Save As dialog box appears.

3 Browse to the location where you want to save the file, name the file, and then click Save.

Editing color values
If an existing spot color is not printing as intended, edit the color values as needed to achieve
your intended result. Edit color values by entering the exact CMYK values in the Spot-On
main window or in the Set Center Patch Color dialog box, or using the Spot-On Color Search
feature.
Use the following procedures to edit a named color by entering the exact CMYK values.
To target a color using Spot-On Color Search, see page 57.
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TO EDIT A COLOR IN THE SPOT-ON MAIN WINDOW
1 Select the color that you want to edit.
2 Double-click the value under C, M, Y, and K, and enter a new number for each color channel.

The edited color appears in the color list.
N OTE : The edited color is not saved until you choose Save from the File menu.

TO EDIT A COLOR IN THE SET CENTER PATCH COLOR DIALOG BOX
1 Select the color you want to edit.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.
3 Click the center patch.

The Set Center Patch Color dialog box appears.

4 Indicate whether you want to enter CMYK values as percentages or Device Codes.

The Percentages option allows you to enter color values between 0 and 100%, in increments
of 0.5. Values out of this range are rounded to the nearest whole or half percentage.
The Device Codes option allows you to enter color values between 0 and 255. This option
reflects the full range of color values that the Fiery EX8000AP can reproduce and provides
finer gradations of color than are possible with Percentages.
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5 Enter the C, M, Y, and K values of your specific color in the appropriate fields.

Use the Tab key to move from field to field. As you enter each new value, the preview patch
updates to reflect the old and new colors.
6 Click OK.

The new color is displayed in the center of the Spot-On Color Search dialog box.
7 Click OK.

The edited color appears in the color list of the Spot-On main window.
Use the following procedure to target a color using the Spot-On Color Search dialog box.
Beginning with an approximate color in the Spot-On Color Search dialog box, adjust the hue,
saturation, and lightness of the color until you achieve an acceptable match.
TO TARGET A COLOR USING SPOT- ON COLOR SEARCH
1 Select the color that you want to edit.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the current color in the center.

3 To update the center patch to a neighboring color that more closely matches the target, click
the corresponding neighbor patch.

Neighboring patches represent variations from the center patch and can be selected if they
offer a closer match to the desired color. Clicking one of these patches updates the center
patch to the new color and provides a new selection of neighboring colors. These patches are
either lightness or saturation neighbors, depending on the option you choose in the following
step.
N OTE : When you select certain colors, an exclamation point icon may appear in the

upper-right corner of the dialog box. This icon indicates that one or more colorants have
reached their maximum values.
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4 Use the following techniques to control how neighboring color patches are generated:
Select Lightness or Saturation in the Color Directions Legend.

Lightness generates neighbor patches based on darker to lighter shades of the original color.
This variation is displayed from left to right, with the original color remaining in the center of
the middle group.
Saturation generates neighbor patches based on less saturated to more saturated variations
of the original color. This variation is displayed from left to right, with the original color
remaining in the center of the middle group.
Choose a setting from the Color Spacing menu to control the closeness of the neighbor
patches.

A higher setting generates neighbor patches that differ more noticeably from the center color.
As you get closer to your target color, reduce the color spacing to a smaller value.
Select Monitor Compensation to simulate how all the on-screen color patches appear when
printed on paper.

This simulation depends on the monitor profile configured for your monitor. To specify the
monitor profile, choose Preferences from the Edit menu in the Spot-On main window.
Make sure that you set your monitor according to the manufacturer’s recommendations and
select the correct monitor profile for your monitor, including the FACI monitor.
5 Continue adjusting the color patch controls and clicking neighbor patches until the color you
want appears in the center patch.
6 Click Print Pattern.

N OTE : It is very difficult to accurately match spot colors on a monitor. You should always test

print to get the proper color match.
7 Choose the appropriate settings from the Output Style, Paper Size, and Paper Tray menus.

For Output Style, choose Color Search Pattern or Color Neighbor Pattern. Color Search
Pattern prints patches with the same pattern as displayed in the Color Search dialog box.
Color Neighbor Pattern prints patches in a three column by eight row format.
For Paper Size, choose the size of the paper that you want to use for printing the patches.
For Paper Tray, specify the paper source for the paper that you want to use.

59

SPOT-ON

8 Click OK to print the patches.

The Print Pattern test page provides the following information:
• Center patch color CMYK value
• Color spacing
• Lightness or Saturation neighbors selected
• Output profile selected
The goal of Spot-On Color Search is to find the color values that make a printed color patch
match a target, not its screen simulation of it. Printing a Print Pattern of neighbor color
patches allows you to compare the printed patches to the color target. After you compare the
printed patches and find the one that matches most closely, you can select the corresponding
patch on-screen.
9 Select the desired target color in the Spot-On Color Search dialog box and click OK.

The edited color appears in the color list of the Spot-On main window.

Using a measurement instrument to target colors
If you have the Spectrophotometer ES-1000, you can import measured color values directly
into Spot-On. This feature allows you to target matches based on the actual colors of
immediate objects, such as the red of a printed logo or the yellow of a packaging envelope.
TO IMPORT COLOR MEASUREMENTS

INTO SPOT- ON

1 Install and set up the ES-1000 for use with your computer.

For installation and setup instructions, see the documentation that accompanies the
instrument.
2 Choose Start from the Instrument menu.

The Choose Port dialog box appears.
3 For Instrument, choose the instrument that you will use to take measurements. For Port,
choose the serial port connection of the instrument. Click OK.
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4 Place the ES-1000 over the target color, making sure to center the sample aperture over the
color. Press Measure to take the measurement.

The measured CMYK values are imported into Spot-On as follows:
• If an individual color is selected in the color list, it updates to the measured color.
• If a group is selected in the color list, a new color with the measured values is created
within the group.
• If the Spot-On Color Search dialog box is open, the center patch updates with the
measured values, and the neighbor patches update accordingly.
• If the Set Center Patch Color dialog box is open, the measured values are imported into
the CMYK entry fields.
5 After you finish taking color measurements, choose Stop from the Instrument menu.

Spot-On closes the connection to the instrument.

Reverting default colors to factory settings
You can revert default colors to their factory default settings. Revert all colors within a default
color group, or revert one or more specific colors within a default color group, so that only
those colors are reset to the factory default settings.
TO REVERT ALL COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that you want to revert.
2 Choose Revert Group from the File menu.

A warning message appears.
3 Click OK.

TO REVERT SPECIFIC COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that contains the colors you want to revert.
2 Select the colors that you want to revert to the factory defaults.

To select more than one color, Shift+click to select an adjacent color or CTRL+click to select
a nonadjacent color.
3 Choose Revert Factory Color from the File menu.

A warning message appears.
4 Click OK.
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Saving changes and exiting Spot-On
To enable your spot color matches for use with the Fiery EX8000AP, save your edits before
you exit Spot-On. This ensures that all your changes to Spot-On color definitions are stored
on the Fiery EX8000AP and available for use when printing documents that contain spot
colors.
The following edits do not require saving to take effect:
• Rearranging the priority level of a color group
• Downloading a color group
• Clearing or deleting a color group
TO SAVE THE SPOT- ON COLOR LIST
1 Choose Save from the File menu.
2 Click Close in the upper-right corner of the Spot-On main window to exit the utility.
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Spot-On with Substitute Colors
The Substitute Colors workflow involves defining the substitute color values with Spot-On,
and then printing a document with the Substitute Colors print option set to On from the
printer driver. You can also override the print option setting using Command WorkStation.
N OTE : Color substitutions affect only text, vector, and line art. They have no effect on

raster images.
N OTE : When a color is defined as a substitute color, the settings for an RGB color (such as

RGB Source, Rendering Style, and RGB Separation) or CMYK color (such as CMYK
Simulation Profile and CMYK Simulation Method) have no effect. The color is converted
with a process similar to spot color conversion.
N OTE : You cannot use the Substitute Colors and Postflight features at the same time.

These print options are constrained from the printer driver.
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Creating a color for substitution
Use the following procedure to add a new substitute color in a substitute group and specify
the value-name for a color to substitute.
N OTE : A new substitute color can be added only to a substitute group.

TO ADD A NEW SUBSTITUTE COLOR AND SPECIFY THE VALUE-NAME FOR SUBSTITUTION
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.

Start ColorWise Pro Tools from a stand-alone application or Command WorkStation at your
computer, or at the monitor connected to the Fiery EX8000AP.

2 Click Spot-On.

The Select Output Profile dialog box appears.
3 Select an output profile and click OK.

The Spot-On main window appears.
1
1
2
3
4
5
6
7
8
9
10
11

Output profile
Save
Upload
Download
Cut
Copy
Paste
Close all
Print
Up
Down

2

3

4

5

6

7

8

9

10

11

4 Select the location in the group list where you want to place the addition.
5 Choose New Substitute Group from the Edit menu.

A new substitute group entry appears as Untitled.
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6 Double-click Untitled and type a new name.
7 Select the substitute group and choose New Substitute Color from the Edit menu.

N OTE : If the substitute group already contains substitute colors, select the color above the

location where you want to add a new substitute color.
The Add Substitute Color dialog box appears.

8 Select a color mode for the substitute color.
9 Select a tolerance degree for the substitute color.

For information about Tolerance, see page 69.
10 Type the values for the color that you want to substitute.
11 Click OK.

The substitute color appears at the specified location.

Defining the color values for a substitute color
After you specify the original color to substitute, define CMYK values for the substitute color
by typing the exact CMYK values in the Spot-On main window or Set Center Patch Color
dialog box, or use Spot-On Color Search.
For instructions on defining a substitute color by typing the exact CMYK values, see the
following sections. To define a substitute color in the Spot-On Color Search dialog box,
see page 66.
TO DEFINE A SUBSTITUTE COLOR IN THE SPOT-ON MAIN WINDOW
1 Start ColorWise Pro Tools and connect to the Fiery EX8000AP.
2 Click Spot-On.

The Select Output Profile dialog box appears.
3 Select an output profile and click OK.

The Spot-On main dialog box appears.
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4 Select the color that you want to substitute.
1
1

Output profile

5 Double-click the value under C, M, Y, and K, and type a new number for each color channel.

The new values for the substitute color appear in the color list.
N OTE : The edited color is not saved until you choose Save from the File menu.

TO DEFINE A SUBSTITUTE COLOR IN SET CENTER PATCH COLOR
1 Select the color that you want to substitute.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.

1

Center patch

1
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3 Click the center patch.

The Set Center Patch Color dialog box appears.

4 Type values for each C, M, Y, and K color channel.

For information about using Set Center Patch Color, see page 56.
5 Click OK.

The new color appears in the center in the Spot-On Color Search dialog box.
6 Click OK.

The new color appears in the color list of the Spot-On main window.
N OTE : The edited color is not saved until you choose Save from the File menu.

Use the following procedure to target a substitute color using the Spot-On Color Search
dialog box.
TO DEFINE A SUBSTITUTE COLOR USING SPOT- ON COLOR SEARCH
1 Select the color that you want to substitute.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears, displaying the current color in the center.

1

Neighboring patch

1
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3 Click neighboring patches until you find the color that you want to use for the substitution.

For information about using Spot-On Color Search, see page 57.
4 Click OK.

The new substitute color appears in the color list of the Spot-On main window.
N OTE : The edited color is not saved until you choose Save from the File menu.

Printing a job with a substitute color
After you define CMYK values for substitution in Spot-On, you can print a document with
the substitute color from the printer driver. You can also override the print option setting
using Command WorkStation.
N OTE : When you print a job, select the same output profile from the printer driver as the one

that was selected in the Select Output Profile dialog box. Otherwise, color substitutions that
are defined on Spot-On have no effect.
N OTE : The procedures for printing a job from a Mac OS and a Windows computer

are similar.
TO PRINT A JOB WITH A SUBSTITUTE COLOR
1 Open a document in your application.
2 Choose Print.
3 Click Copies & Pages and choose ColorWise from the menu.

The ColorWise pane appears.
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4 Select Substitute Colors.
5 Click Print.

The job is printed with the substitute you defined in Spot-On.

Substitute Color dialog box
You can define the color mode and tolerance range for a substitute color in the Add Substitute
Color or Rename Substitute Color dialog box.

N OTE : The Add Substitute Color dialog box appears when you choose Edit>New Substitute

Color after selecting a substitute color group in the list. The Rename Substitute Color dialog
box appears when you double-click the bracketed section of a substitute color.
N OTE : The Add Substitute Color and Rename Substitute Color dialog boxes offer the same

control in defining a substitute color.
• Substitute Color: Select the following color modes for a substitute color:
– CMYK (0-100%)
– RGB (Device Code 0-255)
– RGB (0-100%)
• Tolerance: Select the following tolerance ranges for a substitute color:
– Small (indicated in lowercase)
– Large (indicated in uppercase)
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To avoid entry errors, the Add Substitute Color and Edit Substitute Color dialog boxes
display the values in the following predefined formats. The dialog boxes also display uppercase
or lowercase characters and a percentage (%) symbol, depending on the selections.
• CMYK (0-100%) mode

– Small: <“0”%c, “0”%m, “0”%y, “0”%k>
– Large: <“0”%C, “0”%M, “0”%Y, “0”%K>
• RGB (Device Code 0-255) mode

– Small: <“0”r, “0”g, “0”b>
– Large: <“0”R, “0”G, “0”B>
• RGB (0-100%) mode

– Small: <“0”%r, “0”%g, “0”%b>
– Large: <“0”%R, “0”%G, “0”%B>

Principles for Substitute Colors
In setting the values for Substitute Colors, keep in mind the following principles.
Tolerance range
The accuracy of the substitute color is affected by various elements, such as applications,
operating systems, printer drivers, and distilling processes. To accommodate the “errors” that
occur because of the rounding rules between the numbers entered by users and the numbers
received by the Fiery EX8000AP, the options of the small and large tolerance ranges are
provided for color substitution.
The following table provides Small and Large substitution tolerance ranges for each
color mode.
Color mode

Small tolerance range

Large tolerance range

CMYK (0-100%)

+/- 0.25%

+/- 0.5%

RGB (Device Code 0-255)

+/- 0.25

+/- 1

RGB (0-100%)

+/- 0.25%

+/- 0.5%

N OTE : Values for tolerance ranges are approximate.
• CMYK (0-100%)

– Small: A substitute color replaces any color that falls within the nearest +/- 0.25% of
the color value entered.
– Large: A substitute color replaces any color that falls within the nearest +/- 0.5% of the
color value entered.
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• RGB (Device Code 0-255)

– Small: A substitute color replaces any color that falls within the nearest +/- 0.25 of the
color value entered.
– Large: A substitute color replaces any color that falls within the nearest +/- 1 of the
color value entered.
• RGB (0-100%)

– Small: A substitute color replaces any color that falls within the nearest +/-0.25% of the
color value after scaling.
– Large: A substitute color replaces any color that falls within the nearest +/-0.5% of the
color value after scaling.
Color substitution
A color substitution takes place when a substitute color is defined with a different set of
CMYK values for the same value-name as the original color.
The following color examples show how a substitution works.
• Original color: <100, 0, 0, 0> for the CMYK values (cyan)
• Substitute 1: <0, 100, 100, 0> (red)
• Substitute 2: <100, 0, 100, 0> (green)
N OTE : In the examples, the extreme values and terms “red” and “green” are used for illustrative

purposes only. In practice, color substitution is not used for extreme color shifts.
The following table shows color substitution with different sets of CMYK values assigned to
the same original color.
Substitution
value-name

CMYK
values

Before
substitution

After
substitution

Original color

—

<100, 0, 0, 0>

—

—

Substitute 1

<100.0c, 0.0m, 0.0y, 0.0k>

<0, 100, 100, 0>

cyan

red

Substitute 2

<100.0c, 0.0m, 0.0y, 0.0k>

<100, 0, 100, 0>

cyan

green

Priority scheme
If two substitute colors are defined with the same value-names, but with different sets of
CMYK values and different tolerance ranges, Spot-On resolves the priority of substitution
according to the order of color in the group.
Spot-On process color substitution is based on the order of color in the group. The color
entries at the top of the list have priority over the colors at the bottom of the list. Spot-On
scans the list from top to bottom and processes substitution in linear order. When a color is
remapped, it is not overridden by any subsequent substitution call.
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The following color examples show how the priority scheme works.
• Original color: <100, 0, 0, 0> for the CMYK values (cyan)
• Substitute 3: <0, 100, 100, 0> (red) with a small tolerance
• Substitute 4: <100, 0, 100, 0> (green) with a large tolerance
N OTE : In the examples, the extreme values and terms “red” and “green” are used for illustrative

purposes only.
Order of the colors

• Case 1: Substitute 3 (red) is higher than Substitute 4 (green) in the list.
• Case 2: Substitute 4 (green) is higher than Substitute 3 (red) in the list.
The following table shows the scheme of priority when the same value-names are assigned to
the original color with different sets of CMYK values and different tolerance ranges.
Color
order

Substitution
value-name

Original color

CMYK values

Before
substitution

After
substitution

<100, 0, 0, 0>

Case 1

Substitute 3
Substitute 4

<100.0c, 0.0m, 0.0y, 0.0k>
<100.0C, 0.0M, 0.0Y, 0.0K>

<0, 100, 100, 0>
<100, 0, 100, 0>

cyan

red
(see the following)

Case 2

Substitute 4
Substitute 3

<100.0C, 0.0M, 0.0Y, 0.0K>
<100.0c, 0.0m, 0.0y, 0.0k>

<100, 0, 100, 0>
<0, 100, 100, 0>

cyan

green
(see the following)

Substitute 3 and Substitute 4 have the same value-names, but depending on their order in the
list, Spot-On produces different results.
• In Case 1, Substitute 3, red, is given higher priority because it is higher in the list. All
occurrences of the original color, cyan, within the Small tolerance range are substituted
with red. Occurrences of cyan within the Large tolerance range, but not within the Small
tolerance range, are substituted with Substitute 4, green.
• In Case 2, Substitute 4, green, is given higher priority because it is higher in the list.
Substitute 3, red, can only substitute for occurrences of the original color, cyan, within the
Small tolerance range, and those occurrences have already been substituted with green.
Therefore, no substitution with red takes place.

Uploading and downloading a substitute color group
Like named color groups, you can upload or download a substitute color group as an ICC
profile. The substitute color definitions are saved with private tags as part of an ICC profile,
allowing you to export the Substitution Group definitions between multiple print servers.
However, Substitution Group definitions are recognized only by the Fiery EX8000AP with
Graphic Arts Package, Premium Edition enabled.
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COLORWISE PRINT OPTIONS
The ColorWise color management system provides print options that affect the output of
objects in various color spaces. By specifying the appropriate settings for each print option,
you can obtain the expected results for your jobs.

About this chapter
This chapter provides an overview of the ColorWise management system, which controls
color on the Fiery EX8000AP (see page 73). It also includes a detailed explanations of each
print option. For the location of each print option, see the following table.
ColorWise print option

See

Auto Trapping

page 74

Black Overprint

page 75

Black Text/Graphics

page 76

CMYK Simulation Profile

page 77

CMYK Simulation Method

page 78

Combine Separations

page 78

Composite Overprint

page 79

Output Profile

page 80

Print Gray using Black Only

page 80

Rendering Styles

page 81

RGB Separation

page 82

RGB Source Profile

page 82

Spot Color Matching

page 84

Substitute Colors

page 85

This chapter also provides information about PostScript printer drivers and instructions for
setting the ColorWise print options for Windows and Mac OS computers. For information
about printer drivers, see page 86.
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Managing color on the Fiery EX8000AP
To modify Fiery EX8000AP printing behavior, do any of the following:
• Specify ColorWise options for an individual print job using the menus that appear in the
printer driver.
• Specify most ColorWise options as server defaults from Color Setup in ColorWise Pro
Tools (see page 29). You can also set default values from Fiery EX8000AP Setup, as
described in Configuration and Setup. The defaults apply to all subsequent print jobs unless
you override them.
• Specify ColorWise options, particularly default ICC profile settings and calibration
options, from ColorWise Pro Tools. These options include default Simulation Profile (see
page 77), Simulation Method (see page 78), default Source Profile (see page 82), RGB
Separation (see page 82), and associated calibration set (see page 33).
Applications allow you to generate color data for the Fiery EX8000AP in many different color
spaces. The most common type of color data produced from office applications is RGB,
while prepress applications generally produce CMYK data. Desktop applications also generate
spot colors, such as PANTONE colors. To complicate matters, a single page may contain a
mix of RGB, CMYK, and spot colors. The Fiery EX8000AP allows you to control the
printing of mixed-color documents with features that apply specifically to RGB, CMYK, or
spot color data.
The following diagram illustrates the print options in the Fiery EX8000AP color management
process that affect color data conversions. You can access these print options when you send a
print job to the Fiery EX8000AP. Most of these options and settings are described in
subsequent sections of this chapter.
RGB data

RGB Source Profile
Print Gray using Black Only
(RGB)
Rendering Style (CRD)
Brightness
Black Text/Graphics
RGB Separation
Output Profile

CMYK data

CMYK Simulation Profile
CMYK Simulation Method
Print Gray using Black Only
(CMYK)
Brightness
Black Text/Graphics
Combine Separations
Output Profile

Spot color data

Fiery
EX8000AP
color processor

Color data sent
to digital press

Spot Color Matching

RGB Source Profile is the only color option that applies strictly to RGB color data. The other
options that affect RGB color also affect the more rarely used Lab, XYZ, and other calibrated
color spaces.

COLORWISE PRINT OPTIONS

74

N OTE : With PostScript 3, a PostScript job can include calibrated CMYK (or

CIEBasedDEFG) data. The Rendering Style print option, which normally affects only RGB
data, affects calibrated CMYK data as well. The RGB Source Profile setting does not affect
calibrated CMYK data.

ColorWise print options
The following sections provide detailed explanations of the ColorWise print options and how
these options affect print jobs.
N OTE : For information about the following print options, see Graphic Arts Package.

• Halftone Screen
• Paper Simulation
• Substitute Colors
• 2-Color Print Mapping

Auto Trapping
Trapping is a technique where the size of objects is modified so that colors printed next to
each other overlap slightly, to prevent white spaces between two colors. These white spaces, or
“halos,” can be caused by factors such as misregistration, the physical properties of the toners,
and the stiffness of the media. The following illustration shows the same image with and
without trapping.

If you enable the Auto Trapping option, trapping is applied to all the objects in a job.
The Fiery EX8000AP is shipped with trapping values that are optimized for a Fiery-driven
print device using regular paper. If these values do not provide the results necessary for the
media that you use, and if Graphic Arts Package, Premium Edition is configured on the Fiery
EX8000AP, you can modify the values to meet your requirements. For more information, see
Graphic Arts Package.
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Black Overprint
The Black Overprint option allows you to specify whether or not black text or black text and
graphics, defined as RGB=0, 0, 0, or as CMYK=0%, 0%, 0%, 100%, overprints colored
backgrounds.
• Text: Black text overprints colored backgrounds, eliminating white gaps and reducing the
halo effect or misregistration of colors. You can choose this setting only if the Black Text/
Graphics option is set to Pure Black On.
• Text & Graphics: Black text and graphics overprint colored backgrounds, eliminating
white gaps and reducing halo effects or misregistration of colors. You can choose this
setting only if the Black Text/Graphics option is set to Pure Black On.
• Off: Black text or text/graphics knocks out colored backgrounds.
N OTE : Before sending the print job to the digital press, PostScript applications may perform

their own black overprint conversions.
One example of how you might use this setting is a page that contains black text on a light
blue background. The background blue is CMYK=40%, 30%, 0%, 0%. The black text is
CMYK=0%, 0%, 0%, 100%.
• With Black Overprint set to Text or Text & Graphics, the final text or text/graphic
portions of the page are overprinted, or combined with the underlying color. Black colors
generated by applications (for example, RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) are
printed using the black toner. This means that black text and line art does not exhibit
halftone artifacts (as long as the digital press is calibrated correctly). No transition in cyan
and magenta toners occurs. The quality of the output is improved because it does not show
artifacts near the edges of the text defined in the RGB color space (RGB=0, 0, 0).
• With Black Overprint Off, the border of the text or text/graphics is on an edge that has
cyan and magenta toners on one side (outside the text) and black toner on the other side
(inside the text). This transition may cause visible artifacts due to the practical limitations
of the digital press.
N OTE : Setting Black Overprint to Text/Graphics allows black text or graphics to overprint

color backgrounds (see “CMYK Simulation Method” on page 78).
N OTE : The reproduction of CMYK components is affected by the CMYK Simulation setting

and calibration curve when CMYK is not 0%, 0%, 0%, 0%.
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Black Text/Graphics
The Black Text/Graphics option affects black text and vector graphics. Under most
circumstances, set this option to Pure Black On. When Black Text/Graphics is set to Pure
Black On, black colors generated by applications (for example, RGB=0, 0, 0 or CMYK=0%,
0%, 0%, 100%) are printed using black toner only. The black text and line art do not exhibit
halftone artifacts (as long as the digital press is calibrated correctly) and are not misregistered,
since one toner is used. In addition, this setting eliminates blasting. This option must be set
to Pure Black On if you want to set the Black Overprint option to Text or Text/Graphics.
For some jobs, it is preferable to clear this option, for example, if the page includes gradient
fills that use black. The following table describes the behavior of the Black Text/Graphics
option with black data defined in different color spaces.
N OTE : Use the Black Text/Graphics option only when printing composites, not when printing

separations.
Color

Black Text/Graphics = Normal

Black Text/Graphics = Pure Black On or
Rich Black On

RGB=0,0,0

RGB=0,0,0 is printed according to the definition
for RGB=0,0,0 in the output profile. This may
be a rich black using all toners if the output
profile specifies a rich black, or may be K-only
if the output profile specifies K-only for
RGB=0,0,0. The output is affected by the
calibration curve.

RGB=0,0,0 is printed as K-only, using the black
toner (Pure Black On) or 100% K plus 50%
Cyan (Rich Black On) using black and cyan
toners. All other RGB values are unaffected by
the Black Text/Graphics setting.

CMYK=0%,0%,0%,100% may be printed as
K-only or as a rich black using all toners,
depending on the CMYK Simulation Profile
and CMYK Simulation Method settings.

CMYK=0%,0%,0%,100% is printed as K-only,
using the black toner (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using black
and cyan toners, regardless of the CMYK
Simulation Profile and CMYK Simulation
Method settings. All other CMYK values are
unaffected by the Black Text/Graphics setting.

(all other RGB values are
unaffected by the Black Text/
Graphics setting)

CMYK=0%,0%,0%,100%
(all other CMYK values are
unaffected by the Black Text/
Graphics setting)

For Quick and Full (Source GCR),
CMYK=0%,0%,0%,100% prints as K-only
and the amount of black toner is limited by
the simulation profile and the calibration curve.
For Full (Output GCR),
CMYK=0%,0%,0%,100% prints as K-only
and the amount of black toner is limited by
the simulation profile and the calibration curve.

Setting CMYK Simulation to ColorWise Off
disables the simulation profile and the
calibration curve. In this case, the black toner
is not limited by the calibration curve.

Setting CMYK Simulation to ColorWise Off
disables the simulation profile and the
calibration curve. In this case, the black toner
is not limited by the calibration curve.
Spot Colors
(unaffected by the Black Text/
Graphics setting)

Standard spot color processing

Standard spot color processing

COLORWISE PRINT OPTIONS

77

N OTE : PostScript applications, such as QuarkXPress, may convert elements defined as

RGB=0, 0, 0 to four-color CMYK black before sending the job to the Fiery EX8000AP.
These elements are not affected by the Black Text/Graphics option. For more information, see
Fiery Color Reference. Also, black text and line art defined as RGB=0, 0, 0 in office
applications, such as Microsoft Word, are converted to single-color black (CMYK=0%, 0%,
0%, 100%) by the Microsoft PostScript 3 printer driver for Windows 2000/XP/Server 2003.
To print this single-color black at the maximum toner density of the digital press, set Black
Text/Graphics to Pure Black On.

CMYK Simulation Profile
The CMYK Simulation Profile print option allows you to print press proofs or simulations.
This setting specifies the offset press standard or other color printing device that you want to
simulate. This option affects CMYK data only.
With Windows printer drivers, you can also view an unlimited number of custom Full
simulations created using ColorWise Pro Tools. On Mac OS computers, you can view up to
10 Full custom simulations. The number of custom simulations is limited by the available
disk space on the Fiery EX8000AP.
If you are printing with the PostScript driver and have Two-Way Communication enabled,
the name of each downloaded or custom profile appears in the CMYK Simulation Profile
menu. If Two-Way Communication is not enabled, downloaded or custom profiles appear as
Simulation-1 through Simulation-10. For more information about Two-Way
Communication, see Printing from Windows or Printing from Mac OS.
The None setting sends your original CMYK data to the digital press in its calibrated state,
without conversions to simulate another printer. The ColorWise Off setting sends your
original CMYK data to the digital press in an uncalibrated state, without conversions to
simulate another printer. This setting is not generally recommended, unless you want to
bypass the ColorWise conversion and use another color management system.
The CMYK Simulation Profile setting you specify depends on the press standard for which
the CMYK data was separated.
• For images that were separated using a custom separation (such as a separation produced
with an ICC profile), choose the corresponding profile on the Fiery EX8000AP with the
CMYK Simulation Profile setting.
• For images that were separated for SWOP, choose SWOP as the CMYK Simulation Profile
setting.
To properly simulate a printed image that was separated using an ICC profile, the same profile
must be present on the Fiery EX8000AP. For more information about downloading ICC
profiles to the Fiery EX8000AP, see page 12.
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CMYK Simulation Method
The CMYK Simulation Method allows you to define your preferred CMYK-to-CMYK
conversion technique.
• Quick applies one-dimensional transfer curves to adjust output densities in the cyan,
magenta, yellow, and black channels. This technique leads to eye-pleasing color output
from your digital press because pure primary colors are not “contaminated” by other
colorants. While it is the fastest simulation method and perfect for drafts, avoid using it
for final documents that are used as press proofs. Other techniques offer the color
simulation accuracy required by proofing applications.
• Full (Source GCR) provides a complete and accurate simulation based on colorimetric
transformations. Hues are preserved, even for primary colors. The Gray Component
Replacement (GCR) level that was specified in the original (source) document is also
preserved for K-only text and graphics. Processed black expressed in CMY is reproduced
using CMY toner. Full (Source GCR) is recommended for the highest quality press
proofing applications.
• Full (Output GCR) is a complete and accurate simulation method based on colorimetric
transformations. Hues are preserved, even for primary colors. With this method, the Gray
Component Replacement (GCR) level that was specified in the original document is not
preserved. Instead, all CMYK data is reseparated using the GCR level specified by the
output profile. This simulation technique is similar to traditional ICC color matching
methods and is more appropriate than Full (Source GCR) for full color printing designed
for the press, but reproduced on your digital press.
N OTE : When you specify Pure Black On for Black Text/Graphics and Full (Output GCR) for

CMYK Simulation Method, the black text and graphics in your document are printed with
100% black-only toner.

Combine Separations
The Combine Separations setting specifies how to print separated CMYK data. It supports:
Cyan, Magenta, Yellow, Black, and one or more spot colors. With the Graphic Arts Package,
you can combine an unlimited number of spot color separations along with the CMYK
separations.
• Off prints each separation individually.
• On combines separations as a single, composite-color document, and automatically makes
the settings for the following print options: Color Mode (CMYK), Black Text/Graphics
(Normal), Black Overprint (Off ), and Spot Color Matching (Off ).
The results of combining the multiple plates are predictable and accurate, regardless of the
original application used. This feature also fully supports DCS 2.0 file formats when included
in a PostScript print job from a page layout application.
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The following applications have been tested with Mac OS and Windows for compatibility
with the Combine Separations option:
• Adobe Illustrator
• Adobe InDesign
• Adobe PageMaker
• Macromedia FreeHand
• QuarkXPress
For information about using the Combine Separations option with applications such as
Photoshop, see Fiery Color Reference.

Composite Overprint
When overlapping objects are printed, the foreground object can either overprint or knock
out the background object. With overprinting, the color of the background object shows
through the foreground object where they overlap, and the resulting color is a combination of
the colors of the two objects. With a knock-out, the foreground object hides the background
object where they overlap.
The Composite Overprint print option allows you to print overprinted objects as specified in
the source file. By default, the Composite Overprint print option is off and overlapping
objects print as knockouts.
The Composite Overprint print option is supported for PostScript and PDF jobs produced
by the following applications:
• Adobe Acrobat
• Adobe Illustrator
• Adobe InDesign
• Macromedia FreeHand
• QuarkXPress
• CorelDRAW
If Composite Overprint is enabled for a job that contains spot colors, Spot-On must be
enabled on the Fiery EX8000AP.
A job with more than 32 spot colors may not print as expected.
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Output Profile
Because the output profile is applied to all data in the print job, make sure the profile you
select is the right one for your job. The default output profile consists of a profile for your
digital press that describes its color characteristics and a calibration target that describes the
expected behavior of the digital press.
Use the ColorWise Pro Tools Profile Manager to download your own output profile to the
Fiery EX8000AP (see “Using Profile Manager” on page 23). Downloaded output profiles are
at first associated with the calibration target that is tied to the default output profile. You can
edit calibration target D-Max values separately.
If you are printing with the PostScript driver and have enabled Two-Way Communication,
the name of each downloaded or custom profile appears in the Output Profile menu. If
Two-Way Communication is not enabled, downloaded or custom profiles appear as Output-1
through Output-10. For more information about Two-Way Communication, see Printing
from Windows or Printing from Mac OS.
Select the Use Media Defined Profile setting to automatically apply the output profile
associated with the media type used in a print job, rather than setting a specific output profile.
For more information, see “Using media-defined output profiles” on page 24.
Select the Use Server’s Default setting to use the default Output Profile set in Color Setup. For
more information about Color Setup, see “Using Color Setup” on page 29.

Print Gray using Black Only
When Print Gray using Black Only is enabled, any gray (any color where R=G=B or C=Y=M,
or any K-only color) in a job is printed using only black toner instead of processed black.
You can choose to apply the Print Gray using Black Only option to either Text and Graphics
or to Text, Graphics, and Images.
The following limitations apply:
• The Print Gray using Black Only option has no effect on a job that is pre-separated, except
that if Print Gray using Black Only (CMYK) is off, each separation, which is a grayscale
image, is printed in a 4-color gray.
• If CMYK Simulation Method is set to Full (Source GCR) or Quick, the Print Gray using
Black Only (CMYK) setting does not affect the output.
• If RGB Separation is set to Simulation, the Print Gray using Black Only (RGB) option is
disabled. Likewise, if the Print Gray using Black Only (RGB) option is enabled, you
cannot set RGB Separation to Simulation.
• If Black Text/Graphics is set to Pure Black On or Rich Black On, it takes precedence over
Print Gray using Black Only for 100% black text and graphics.
• If a gray is specified as a spot color, the Print Gray using Black Only option does not affect
that gray.
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Rendering Styles
The Rendering Style option specifies a CRD for color conversions. To control the appearance
of images, such as prints from office applications or RGB photographs from Photoshop, select
the appropriate rendering style. The Fiery EX8000AP allows you to choose from the four
rendering styles currently found in industry standard ICC profiles.
Fiery EX8000AP
rendering style

Best used for

Equivalent ICC
rendering style

Photographic: Typically results

Photographs, including scans and
images from stock photography
CDs and digital camera images.

Image, Contrast,
and Perceptual

Presentation: Creates saturated
colors but does not match printed
colors precisely to displayed colors.
In-gamut colors, such as flesh
tones, are rendered well. This style is
similar to the Photographic
rendering style.

Artwork and graphs in
presentations. In many cases, this
style can be used for mixed pages
that contain presentation graphics
and photographs.

Saturation,
Graphics

Relative Colorimetric: Provides

Advanced use when color matching
is important, but you prefer white
colors in the document to print
as paper white. This style may
also be used with PostScript color
management to affect CMYK
data for simulation purposes.

Relative
Colorimetric

Situations when exact colors are
needed and visible borders are not
distracting. This style may also be
used with PostScript color
management to affect CMYK
data for simulation purposes.

Absolute
Colorimetric

in less saturated output than
presentation rendering when
printing out-of-gamut colors. This
style preserves tonal relationships in
images.

white-point transformation between
the source and destination white
points. For example, the bluish
white color (gray) of a monitor is
replaced by paper white. This style
avoids visible borders between
blank spaces and white objects.
Absolute Colorimetric: Provides
no white point transformation
between the source and destination
white points. For example, the bluish
white color (gray) is not replaced
by paper white.
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RGB Separation
The RGB Separation option determines how RGB colors (as well as Lab and XYZ colors) are
converted to CMYK. The name of this option is meant to be descriptive because the option
defines the color spaces that are used by the Fiery EX8000AP to “separate” the RGB data into
CMYK values.
The two choices available for this option determine whether RGB data is converted into the
full gamut of the digital press (output) or is first converted into the gamut of another digital
printer or press standard (simulation). This feature helps make one device behave like
another for RGB data. For example, if a high-quality ICC profile is available for another print
device, the digital press can simulate the behavior of that device.
RGB Separation is also useful for prepress applications. For example, it allows you to
experiment with the appearance of an RGB scan under different press printing conditions,
without having to convert the RGB data to CMYK data for each condition. When the desired
printing condition is found, convert the file to CMYK, using the same CMYK simulation
profile that you used during the experimentation.
N OTE : Use the RGB Separation print option in conjunction with the Output Profile or

CMYK Simulation Profile print options.
• Output converts all RGB colors into the CMYK color space of your digital press (when
set to the printer’s default), or a customized CMYK color space for your digital press
(when set to Output 1-10).
• Simulation converts all RGB colors into the CMYK color space for a specified simulation
(select the desired simulation with the CMYK Simulation Profile print option).

RGB Source Profile
The RGB source profile setting allows you to define the characteristics of the RGB data in
your document so that the appropriate color conversion occurs on the Fiery EX8000AP.
Commonly used monitor color spaces are available from the printer driver and the Fiery
EX8000AP. For others, use ColorWise Pro Tools Profile Manager to download custom
monitor or scanner profiles.
When you specify a setting other than None for the RGB Source Profile, the Fiery EX8000AP
overrides source color space definitions or profiles that other color management systems may
have specified. For example, if you specified a ColorSync System Profile on your Mac OS
computer, the RGB Source Profile setting overrides it. In cases where you do not want this
setting to override another specified source color space, choose None.
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When you specify a setting other than None, because the color space definitions are
overridden, the output from the Fiery EX8000AP is consistent across platforms. The Fiery
EX8000AP RGB Source Profile options are as follows:
• EFIRGB specifies an EFI-defined color space recommended for users who have no detailed
information about their RGB data.
• sRGB (PC) specifies the definition of a Windows computer monitor profile used as the
default.
• Apple Standard specifies the definition of a Mac OS computer monitor profile used as the
default.
• Adobe RGB (1998) is an Adobe-defined color space for use in pre-press as the default
working space in Photoshop 5.
• ECI-RGB is the European Color Initiative (ECI) recommended space. Use as an RGB
working color space and color data exchange format for ad agencies, publishers,
reproduction and printing houses.
• Fiery RGB is an EFI-defined color space recommended for users of office applications. This
color space is similar to EFIRGB, but is larger and can provide a more desirable blue
output.
• Sources 1-10 specify the definitions you download as RGB source profiles.
If you are printing with the PostScript driver and have enabled Two-Way Communication,
the name of each downloaded profile appears in the RGB Source Profile setting menu. If
Two-Way Communication is not enabled, downloaded profiles appear as Source-1
through Source-10. For more information about Two-Way Communication, see Printing
from Windows or Printing from Mac OS.
• None instructs the Fiery EX8000AP to use the RGB sources you defined elsewhere, such as
in the application. When you set RGB Source to None, the appearance of colors is not
independent of the file type. For example, RGB EPS files looks different from RGB TIFF
files.
With RGB Source set to None, PostScript RGB data that contains a source color space
definition is converted using the CRD specified by the Rendering Style option (see
“Rendering Styles” on page 81). Non-PostScript RGB data and PostScript RGB data that
does not contain a source color space definition are converted using a general undercolor
removal (UCR) conversion method.
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Spot Color Matching
The Spot Color Matching option provides automatic matching of spot colors with their best
CMYK equivalents.
• On: The Fiery EX8000AP uses a built-in table to generate the closest CMYK matches of
spot colors your digital press can produce. (New tables are generated when you add new
output profiles.)
With Spot-On, the Fiery EX8000AP uses the CMYK matches determined through SpotOn (see page 48).
• Off: The Fiery EX8000AP processes the spot color as CMYK data and uses CMYK
equivalents defined by the spot color manufacturer, such as PANTONE. These are the
same CMYK equivalents used by applications that include spot color libraries.
N OTE : Spot colors that are not included in the built-in table are treated as CMYK.

For jobs that include spot colors, set Spot Color Matching to On unless you are printing press
simulations. In that case, set Spot Color Matching to Off and choose the appropriate CMYK
Simulation setting (see page 77).
For a PDF job that includes spot colors that are not included in the built-in table, setting Spot
Color Matching to On retains the original spot colors. The Fiery EX8000AP references the
built-in table to generate the closest CMYK matches of the original spot color.
N OTE : Use Spot Color Matching only when printing composites, not when printing

separations.
Spot Color Matching and the PANTONE Coated Color Reference
The PANTONE Coated Color Reference prints differently depending on the Spot Color
Matching setting (see Fiery Color Reference).
• On: The Fiery EX8000AP uses a built-in table or, with Spot-On, the Spot-On color
dictionaries to generate the best matches for the PANTONE colors that your digital press
can produce. The PANTONE number is displayed below each swatch.
For more information about Spot-On, see page 48.
• Off: The Fiery EX8000AP prints swatches using the CMYK values recommended by
Pantone, Inc. (and used by applications that provide PANTONE color libraries). The
CMYK values used to generate the color, as well as the PANTONE number of the color,
are printed below each swatch. These CMYK values are printed through the selected
CMYK Simulation and Output Profile settings.
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Substitute Colors
Spot-On allows you to create a list of substitute colors. These are colors that, when called for
in a document by their RGB or CMYK values, are substituted with a different color having
the CMYK values from the Spot-On color dictionary. This permits exact color control and
overrides individual RGB and CMYK colors.
To enable substitute colors for a job, select the Substitute Colors option.
For more information about creating and using substitute colors, see “Spot-On with
Substitute Colors” on page 62.
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Printer drivers and print options
The printer driver writes a PostScript file containing the instructions generated by your
application and the settings for the ColorWise print options you selected. The printer driver
then sends the PostScript file to the Fiery EX8000AP. The Fiery EX8000AP performs
PostScript processing and color conversions and sends raster color data to the digital press.

Setting print options for Windows
This section explains how to set color management print options with the Adobe and
Microsoft PostScript printer drivers for Windows, PostScript 3 printer drivers that take full
advantage of the color features of the Fiery EX8000AP.
Before you proceed, do the following:
• Install the printer driver and the Fiery EX8000AP PPD (see Printing from Windows).
• Set up the Fiery EX8000AP for printing (see Printing from Windows).
N OTE : The following illustrations and instructions do not apply to all applications. Many

applications, such as Adobe PageMaker, Photoshop, Illustrator, QuarkXPress, and
CorelDRAW, have other color management options in addition to those presented in the
printer driver. For information about specific applications, see Fiery Color Reference.
Use the following procedure to set the color options for Windows computers.
TO SET PRINT OPTIONS FOR WINDOWS COMPUTERS
1 Choose Print in your application.
2 Select Fiery EX8000AP as your printer and click Properties.

In the Properties dialog box, the Fiery Printing tab is displayed.
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3 Click the ColorWise icon.

4 Specify the settings for the print options in the Color window.

For information about ColorWise print options, see page 74.
5 Click Expert Settings.

The Expert Color Settings dialog box appears.

This dialog box displays most of the ColorWise print options for the Fiery EX8000AP.
6 Click Update to display the current Fiery EX8000AP settings.

If the Update button does not appear, make sure that Two-Way Communication is set up.
For information about enabling Two-Way Communication, see Printing from Windows.
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7 Specify the settings for the main ColorWise print options.

For most users, the default settings provide adequate color control. For information about
individual print options, see page 74.
8 Click OK to exit Expert Color Settings.
9 Click OK to close the Properties window, and then click OK to send your job.

Setting color management print options for Mac OS
This section explains how to set color management print options with the printer drivers for
Mac OS.
Before you proceed, do the following:
• Install the Fiery EX8000AP PPD (see Printing from Mac OS).
• Set up the Fiery EX8000AP for printing (see Printing from Mac OS).
TO SET PRINT OPTIONS FOR MAC OS X COMPUTERS
1 Choose Print in your application.

The Print dialog box appears.

2 Choose ColorSync from the drop-down list.

The ColorSync pane appears.
3 Choose In Printer from the Color Conversion menu.
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4 Choose ColorWise from the drop-down list.

The ColorWise pane appears.

5 Select Two-Way Communication.

For information about enabling Two Way Communication, see Printing from Mac OS.
6 Specify the settings for the print options in the ColorWise pane.

For information about ColorWise print options, see page 74.
7 Click Expert Settings in the Print Mode pane.

The ColorWise Expert Settings dialog box appears.
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8 Choose settings for the main ColorWise print options.

For information about ColorWise print options, see page 74.
9 Click OK.

The ColorWise pane reappears.
10 Click Print.

Using Expert Color Settings to enable Device Link Profiles
When you print a job, you can enable Device Link Profiles by using the Fiery EX8000AP
printer driver if you have Two-Way Communication enabled. When you enable a Device
Link Profile, you will be able to see the Device Link Profile in use in Expert Color.
N OTE : If Two-Way Communication is not enabled and you select an RGB Source Profile and

Output Profile that correspond to a Device Link Profile, the Device Link Profile is activated,
although you do not see the Device Link Profile in use in Expert Color.
For information about installing and assigning Device Link Profiles, see page 24.
N OTE : The procedures for enabling Device Link Profiles using Expert Color Settings for

Windows and Mac OS X are similar. The following illustrations use Windows screens. Any
differences are noted.
TO USE THE FIERY EX8000AP PRINTER DRIVER TO ENABLE DEVICE LINK PROFILES
1 Enable Two-Way Communication.

For more information about enabling Two-Way Communication, see Printing from Windows
or Printing from Mac OS.
2 From your application, select Print.
3 Select Fiery EX8000AP as your printer and click Properties.
4 Click the Color icon.
5 Click Expert Settings.
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6 Select the Source Profile and the Output Profile.

When you select a Source Profile and Output Profile combination that is defined in a Device
Link Profile, the Device Link Profile is automatically enabled.
When the Device Link Profile is selected, the Color Process workflow updates and some
options may not appear. You will see the message “Device Link Profile in use” under the RGB
Source Profile or CMYK Simulation Profile.

1

Device Link Profile in use

1

7 Click OK to exit Expert Color Settings.
8 Click OK to close the Properties window, and then click OK to send your job.
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IMPORTING DENSITY MEASUREMENTS
This chapter describes Simple ASCII File Format (SAIFF), which you can use to import
density measurements from measurement devices. To use your own measurement data from
an alternate measurement instrument, record your individual readings in a text file, and then
structure the file as follows.

Simple ASCII Import File Format
This format describes Status T measurement data for import into the ColorWise Pro Tools
Calibrator. The three possible file formats are:
• 1D Status T density for EFI 21 patch page
• 1D Status T density for EFI 34 patch page
• 1D Status T density for other pages (maximum of 256 patches per ink)
The file format is ASCII and has no tabs. A single space or multiple spaces are used
as delimiters. Blank lines are not allowed. Each line in the file represents four patches
(C, M, Y, K) of a specific ink value. Comments may be on any line in the file. Comment lines
must start with a pound sign (#) followed by a space. (A line with a pound sign followed by
any character other than a space has been reserved.) Comments must be on a line by
themselves.
Each line of data contains five values. The first number is the sequential patch number (for
EFI 21 and EFI 34 pages) or the ink value percentage (for other pages). The four values that
follow are the density values of C, M, Y, and K of the corresponding patch. Lines are ordered
either by increasing sequential patch numbers, or by increasing the ink percentage.
For Windows computers, the file extension must be .cm1. For Mac OS computers, the file
type must be ‘TEXT’.
Measurement data in EFI 21 and EFI 34 are paper-relative. For other pages, if the first line
corresponds to zero ink value, the Calibrator assumes that the measurement data is absolute
and adjusts it to become paper-relative by subtracting the density values of the first line from
the remaining patches.
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Example of 1D Status T density for EFI 21 patch page
This file format is used to specify the Status T density measurements of the EFI 21 patch
page. The value in the first column is the patch number. The first patch must be 1 and the last
must be 21.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST21
# Cyan Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000

(…more data…)
20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500

Example of 1D Status T density for EFI 34 patch page
This file format is used to specify the Status T density measurements of the EFI 34 patch
page. The value in the first column is the patch number. The first patch must be 1 and the last
must be 34.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST34
# Cyan Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000

(…more data…)
33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500
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Example of 1D Status T density for an arbitrary page
This file format is used to specify the Status T density measurements of a user-defined patch
page. The value in the first column is the ink/toner percentage of the patch. The first
percentage must be 0 and the last percentage must be 100, and the percentages in between
these numbers must increase.
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST
# percnt Cyan Magent Yellow Black
0.0000 0.0300 0.0400 0.0200 0.0400
0.3922 0.0600 0.0700 0.0800 0.0700
1.1765 0.1000 0.1000 0.1000 0.1000

(…more data…)
98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500

95

INDEX

INDEX
A
Absolute Colorimetric rendering style 81
Apple Standard setting, RGB Source Profile
option 83
Auto Trapping option 74

B
Black Overprint option 75
Black Text/Graphics option 76

C
calibration
checking status 47
Comparison Page 35
curves 35, 46
DTP32 37
DTP41 39
ES-1000 41
importing density measurements 92
measurement page 46
measurements 45
overview 45
patches 46
restoring defaults 36
scheduling 47
targets 45, 46
viewing measurements 35
Calibration Files folder 13, 18
Calibrator
Expert mode 34
printing Comparison Page 35
restoring defaults 36
using 21, 33
viewing measurements 35
CMYK Color Reference.ps 13, 18
CMYK Simulation Method option 78
CMYK Simulation Profile option 77
Color Chart 47
Color Editor 21
color management system (CMS) 9
color profiles 10

color reference files
for Windows users 13
Color Reference pages 47
color rendering dictionary (CRD) 9, 81
Color Setup 29
color space 73
ColorWise
key features 9
print options 29
workflow diagram 73
ColorWise Pro Tools
Calibrator 21, 33
checking calibration status 47
Combine Separations option 78
Comparison Page 35
Composite Overprint option 79
composites, printing 76, 78, 84
Configuration page 14, 19, 47
connection, configuring 14, 15, 19, 20
Contrast ICC rendering style 81
CRD 9, 81
custom simulations 77
Custom21.ps 13, 18
Custom34.ps 13, 18

D
densitometer, DTP32 37
density
defined 46
importing 92
look less saturated 47
Device Link Profiles
about 24
assigning settings 26
enabling using Color Setup 30
enabling using Expert Color Settings 90
installing 25
device name 15, 20
DNS name 14, 19
Domain Name Server 19
DTP32, calibrating with 37
DTP41, calibrating with 39

96

INDEX

E
EFIRGB, RGB Source Profile option 83
ES-1000
calibrating with 41
importing measurements with 59, 60

F
Fiery utilities, configuring the connection
for 15, 20
FieryColorBar.eps 13, 18
Full (Output GCR) setting, CMYK Simulation
Method option 78
Full (Source GCR) setting, CMYK Simulation
Method option 78

G
Graphic Arts Package
unlimited separations 78
Graphics ICC rendering style 81

I
ICC profiles 10
defined 9
downloading 24
editing 21
rendering styles 81
Image ICC rendering style 81

L
Lightness, Spot-On 58

M
Mac OS color management options 88
measurements page 46
monitor compensation
Spot-On 58

N
None setting, RGB Source Profile option 83

O
output profile
Spot-On 28, 48, 49, 59, 63, 64, 67
Output Profile option 80
output profiles 46

P
PANTONE Book.ps 13, 18
PANTONE Coated Color Reference 84
passwords, for calibration 33, 45

patches page 46
Perceptual ICC rendering style 81
Photographic rendering style 81
Postflight
named colors 53
PostScript color issues 74, 75, 77, 83
PowerPoint, RGB color reference file 18
PPD 86, 88
Presentation rendering style 81
Print Gray using Black Only option 80
print options
Mac OS 88
setting defaults 29
Windows 86
printer drivers
Mac OS 88
two-way communication 77, 80, 83
Windows 86
Profile Manager
downloading profiles 24
using 23
profiles 10

Q
Quick setting, CMYK Simulation Method
option 78

R
Relative Colorimetric rendering style 81
rendering styles 9, 74
Rendering Styles option 81
RGB images
defining source profiles for 82
PostScript and non-PostScript
conversion 83
RGB page 01 18
RGB page 01.doc 13
RGB page 02 18
RGB page 02.ppt 13
RGB Separation option 82
RGB Source Profile option 73, 82

S
SAIFF format 92
Saturation
Spot-On 58
Saturation ICC rendering style 81

97

INDEX

separations
printing 76, 78, 84
target color space 82
simulations, custom 77
Source 1-10 setting, RGB Source Profile
option 83
spectrophotometer
DTP41 39
Spot Color Dictionaries 28, 48
Spot Color Matching option 84
spot colors, CMYK equivalents 84
spot colors, matching to CMYK
equivalents 28, 48
Spot-On 28, 48
adding color 53
Color Spacing 58
downloading color group 54
editing 55
Set Center Patch Color 56
Spot-On Color Search 57
Spot-On main window 56
ES-1000 59
factory defaults 60
Lightness 58
main window 50
monitor compensation 58
named colors 48
output profile 49, 63, 64
rearranging color group 52
renaming color 53
RGB or CMYK values 48
Saturation 58
Spot Color Matching 48
substitute colors 48
uploading color group 55
using measurement instruments 59
sRGB, RGB Source Profile option 83
Standard21.ps 13, 18
Standard34.ps 13, 18
Status T 92

Substitute Colors
accuracy 69
adding substitute colors 64, 68
CMYK (0-100%) mode 69
color substitution 70
defining 64
Set Center Patch Color 65
Spot-On Color Search 66
Spot-On main window 64
downloading substitute groups 71
new 63
new substitute group 63
principles 69
printing 67
priority scheme 70
renaming substitute colors 68
RGB (0-100%) mode 69
RGB (Device Code 0-255) mode 69
tolerance 68
tolerance range 69
uploading substitute groups 71
vs. Postflight 62
workflow 62
Substitute Colors option 85
SWOP 77

T
targets, for calibration 46
terminology 7, 31
Test Page 47
transfer functions 46
Two-Way Communication 77, 80, 83

U
undercolor removal (UCR) 83

W
Windows Color Files folder 13
Windows, print options 86
Word, RGB color reference file 18

